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1 Introduction

1.1 Add-onModule RF-STEEL EC3

Eurocode 3 [1] describes design, analysis, and construction of steel structures in themember states
of the European Union. With the RFEM add-on module RF-STEEL EC3, DLUBAL provides a powerful
tool for designing steel structures modeled with member elements. Country-specific regulations
are taken into account by National Annexes (NA). In addition to the parameters included in the pro-
gram, you can define your own limit values or create new National Annexes.

RF-STEEL EC3 can carry out all typical ultimate limit state designs as well as stability and deforma-
tion analyses. The program takes into account various actions for the ultimate limit state design.
Furthermore, you can choose between the interaction formulas given in the standard. An essential
part of the analysis according to Eurocode 3 is the classification of the designed cross-sections
into the Classes 1 to 4. In this way, you can check the limitation of the design and rotational
capacity bymeans of the local buckling of cross-section parts. RF-STEEL EC3 determines the c/t-ra-
tios of the cross-section parts subjected to compression stress and performs the classification
automatically.

For the stability analysis, you can specify for each member or set of members whether flexural
buckling occurs in the y- and/or z-direction. You can also define additional lateral restraints in order
to represent the model close to reality. In addition, the stabilizing effect of purlins and sheeting
can be taken into account by rotational restraints and shear panels. RF-STEEL EC3 determines
the slenderness ratios and elastic critical buckling loads on the basis of boundary conditions.
The elastic critical moment for lateral-torsional buckling required for the lateral-torsional buckling
analysis can be determined automatically or specified manually. There is the load application
point of transverse loads considered, effecting the torsional resistance considerably.

RF-STEEL EC3 can also perform the fire resistance design according to EN 1993-1-2 [2]. The design
is carried out on the bearing capacity level according to the simplified calculation method. As fire
protection, you can select encasements with various physical properties.

For structures with slender cross-sections, the serviceability limit state represents an important
design. The load cases, load combinations, and result combinations can be assigned to different
design situations. The limit deformations are preset by the National Annexes and can be adjusted,
if necessary. In addition, you can specify reference lengths and precambers that are considered
accordingly in the design.

RF-STEEL EC3 also allows you to design structural components made of stainless steel according
to EN 1993-1-4 [3].

The program allows you to optimize cross-sections, if required, and then export the modified
cross-sections to RFEM. Using the design cases, you can design separate structural components in
complex structures or analyze variants.

Since RF-STEEL EC3 is integrated in the main program RFEM, the design relevant input data is
already available when you open the module. After the calculation, you can evaluate the designs
graphically in the RFEMworkwindow. Last but not least, it is possible to cover the analysis progress
in the global printout report, from determination of internal forces up to the results of the design.

We wish you enjoyment and success with RF-STEEL EC3.

Your DLUBAL team
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1.2 Using theManual

Topics like installation, graphical user interface, results evaluation, and printout are described in
detail in the manual of the main program RFEM. The present manual focuses on typical features
of the RF-STEEL EC3 add-on module.

The descriptions in this manual follow the sequence and structure of themodule's input and result
windows. In the text, the describedbuttons are given in square brackets, for example [Viewmode].
At the same time, they are pictured on the left. Expressions appearing in dialog boxes, windows,
and menus are set in italics to clarify the explanation.

At the end of the manual, you find the index. However, if you still cannot find what you are
looking for, please check our website www.dlubal.com where you can go through our FAQ pages
by selecting particular criteria.

1.3 Opening RF-STEEL EC3 Add-onModule

RFEM provides the following options to open the RF-STEEL EC3 add-on module.

Menu
To open the program from the RFEMmenu bar, click

Add-onModules → Design - Steel → RF-STEEL EC3.

Figure 1.1: Menu: Add-onModules→Design - Steel→ RF-STEEL EC3
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Navigator
As an alternative, you can open the add-on module in the Data navigator by clicking

Add-onModules → RF-STEEL EC3.

Figure 1.2: Data navigator: Add-onModules→ RF-STEEL EC3

Panel
If results from RF-STEEL EC3 are already available in the RFEMmodel, you can also open the design
modules from the panel:

Set the relevant RF-STEEL EC3 design case in the load case list of the RFEM toolbar. Click the [Show
Results] button to graphically display the design criterion on the members.

Now you can use the [RF-STEEL EC3] button in the panel to open the module.

Figure 1.3: Panel button [RF-STEEL EC3]
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2 Input Data
After you open the add-on module, a new window appears. In this window, a navigator is dis-
played on the left, managing the tables that can be selected currently. The drop-down list above
the navigator contains the design cases (see Chapter 7.1, page 73).

The design-relevant data is defined in several input windows. When you open RF-STEEL EC3 for
the first time, the following parameters are imported automatically:

• Members and sets of members

• Load cases, load combinations, result combinations

• Materials

• Cross-sections

• Effective lengths

• Internal forces (in background, if calculated)

To select awindow, click the corresponding entry in the navigator. To set the previous or next input
window, use the buttons shown on the left. For scrolling in windows, you can also use the function
keys to select the next [F2] or previous [F3] window.

[OK] saves the results. Thus, you exit RF-STEEL EC3 and return to the main program. To exit
the add-on module without saving the new data, click [Cancel].

2.1 General Data

In the 1.1 General Datawindow, you can select the members, sets of members and actions you
want to design. The tabs manage the load cases, load combinations, and result combinations for
different designs.

Figure 2.1: Window 1.1 General Data



2 Input Data

©Dlubal Software GmbH 2015

7

2
Design of

Figure 2.2: Design of members and sets of members

The design can be carried out forMembers as well as for Sets ofMembers. If you want to design only
selected objects, clear the All check box. Then you can access the text boxes to enter the numbers
of the relevant members or sets of members. You can remove the list of preset numbers in the text
box using the [Delete] button. Use the [Select] button to display the objects graphically in the
RFEM work window.

When you design a set of members, the program determines the extreme values of the analyses
of all members contained in the set of members and takes into account the boundary conditions
of connected members for the stability analysis. The results are shown in the result windows
2.3 Design by Set of Members, 3.2 Governing Internal Forces by Set of Members and 4.2 Parts List by
Set of Members.

Click [New] to create a new set of members. The dialog box that you already know from RFEM
appears where you can specify the parameters for a set of members.

National Annex (NA)

Figure 2.3: National Annex

In the drop-down list box in the upper-right corner of the window, you can define the National
Annex. The annex parameters apply for the design and the limit values of the deformation.

Use the [Edit] button to open a dialog box where you can check and/or adjust the parameters of
the selected National Annex. This dialog box is described in Chapter 2.1.4, page 11.

Comment

Figure 2.4: User-defined comment

In this text box, you can enter user-defined notes, for example to describe the current design case.



2 Input Data

©Dlubal Software GmbH 2015

8

2
2.1.1 Ultimate Limit State

Figure 2.5: Window 1.1 General Data, tab Ultimate Limit State

Existing Load Cases and Combinations
This column lists all load cases as well as load and result combinations that have been created in
RFEM.

Use the button to transfer the selected entries to the Selected for Design table on the right.
Alternatively, you can double-click the entries. To transfer the entire list to the right, use the
button.

To transfer multiple entries of load cases, click the entries while pressing the [Ctrl] key, as common
for Windows applications. Thus, you can transfer several load cases at the same time.

Load cases marked in red, like LC 8 to 10 in Figure 2.5, cannot be designed: This happens when
the load cases are defined without any load data or contain only imperfections. Then, when you
transfer the load cases, a corresponding warning appears.

At the end of the list, several filter options are available. They will help you to assign the en-
tries sorted by load case, load combination, or action category. The buttons have the following
functions:

Select all cases in the list

Invert selection of load cases

Table 2.1: Buttons in tab Ultimate Limit State
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Selected for Design
The column on the right lists the load cases as well as the load and result combinations selected
for design. Use the button or double-click the entries to remove selected entries from the list.
Use the button to transfer the entire list to the left.

The load cases, load combinations, and result combinations can be assigned to the following
design situations:

• Persistent and Transient

• Accidental

This classification controls the partial factors 𝛾M0, 𝛾M1 and 𝛾M2 that are included in the determina-
tion of the resistances Rd for the cross-section and stability analyses (see Figure 2.10, page 12).

To change the design situation, use the list at the end of the text box, which you can open by
clicking the drop-down arrow .

Figure 2.6: Assigning design situation

For multiple selection, press [Ctrl] and click the corresponding entries. Thus, you can change
several entries at once.

Result combination

The design of an enveloping max/min result combination is performed faster than the design of
all contained load cases and load combinations. However, the analysis of a result combination has
also disadvantages: First, the influence of the contained actions is difficult to discern. Second, for
the determination of the elastic critical momentMcr for lateral-torsional buckling, the envelope of
the moment distributions is analyzed, from which the most unfavorable distribution (max or min)
is taken. However, this distribution only rarely reflects the moment distribution in the individual
load combinations. Therefore, more unfavorable values forMcr are to be expected in RC design,
leading to higher ratios.

Result combinations should be selected for design only in case of dynamic combinations.
For "usual" combinations, load combinations are recommended, since there are the actualmoment
distributions taken for the determination ofMcr.
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2.1.2 Serviceability Limit State

Figure 2.7: Window 1.1 General Data, tab Serviceability Limit State

Existing Load Cases and Combinations
This section lists all load cases, load combinations, and result combinations that have been created
in RFEM.

Selected for Design
You can add or remove load cases as well as load and result combinations as described in Chap-
ter 2.1.1.

You can assign different deflection limit values to the individual load cases, load combinations
and result combinations. You can select from the following design situations:

• Characteristic

• Frequent

• Quasi-permanent

To change the design situation, use the list at the end of the text box, which you can open by
clicking (see Figure 2.7).

The limit values of the deformations are defined in the National Annex. To adjust these values
according to the design situation, click the [Nat. Annex] button. TheNational Annex Settings dialog
box appears (see Figure 2.10, page 12).

In the 1.9 Serviceability Datawindow, you can specify the reference lengths that are governing for
the deformation analysis (see Chapter 2.9, page 31).
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2.1.3 Fire Resistance

Figure 2.8: Window 1.1 General Data, tab Fire resistance

Existing Load Cases and Combinations
This section lists all load cases, load combinations, and result combinations created in RFEM.

Selected for Design
You can add or remove load cases as well as load and result combinations, as described in Chap-
ter 2.1.1. In this dialog section, you can select the actions that have been determined according to
EN 1991-1-2 [2].

2.1.4 National Annex (NA)

In the upper-right list of the 1.1 General Data window, you can select the National Annex with
parameters valid for the design and limit values of the deformation.

Figure 2.9: Selecting the National Annex

Click the [Edit] button to check and, if necessary, adjust the preset parameters (see the following
figure).
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Click the [New] button to create a user-defined National Annex.

In addition, you can use the [Nat. Annex] button available in all input windows. Thus, you open
the National Annex Settings dialog box, that consists of two tabs.

Base

Figure 2.10: Dialog box National Annex Settings - CEN, tab Base

In the individual sections of this tab, you can check the Partial Factors, the Serviceability Limits
(Deflections), as well as the Parameters for Lateral-Torsional Buckling and adjust them, if necessary.

In the General Method Acc. to 6.3.4 section, you can determine the stability analysis to be always
performed according to [1], Clause 6.3.4. The German National Annex sets the General Method
applicable only for I-shaped cross-sections. The option Enable also for non I-sections allows you to
use the method also for other cross-sections.

In addition, you can perform the stability analysis using the European lateral-torsional buckling
curve according to NAUMES [4]. In his dissertation [5], NAUMES adapted the “General Method for
buckling and lateral-torsional buckling designs of structural components” according to [1], Clause
6.3.4 for additional transverse bending and torsion. This Adapted Method is now available for
designing unsymmetrical cross-sections as well as for taperedmembers and sets of members with
biaxial bending (torsion is currently not considered in RF-STEEL EC3).

According to [1], Clause 6.3.4 (4), the reduction factor 𝜒op is to be calculated either

a) as the minimum value of buckling according to 6.3.1 or 𝜒LT for lateral-torsional buckling ac-
cording to 6.3.2 using the slenderness ratio 𝜆op, or

b) as the value interpolated between 𝜒 and 𝜒LT - see also [1], Equation (6.66).

Since the method according to NAUMES is based on the standardized European lateral-torsional
buckling curve considering the modified imperfection factor 𝛼∗, the interaction between local
buckling and lateral-torsional buckling according to [1], Equation (6.66) is not applied.
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Figure 2.11: Calculation for the method according to NAUMES

In the first step, the calculation is carried out separately for the main and the secondary load-bear-
ing plane. Simultaneously, the moment factor qmZ is determined according to Figure 2.12.

In the second step, the design criterion 𝛥nR is determined.

Finally, the design is performed by summing up the design ratios for the main and the secondary
load-bearing plane and compared to the design criterion 𝛥nR.

Figure 2.12: Determining the moment factor qMz

The buttons in the National Annex Settings dialog box have the following functions:

Button Function

Reset original settings of the program

Import user-defined default settings

Save modified settings as default

Delete user-defined National Annex

Table 2.2: Buttons in the dialog box National Annex Settings
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Stainless Steel (EN 1993-1-4)
In RF-STEEL EC3, it is possible to design also structural components made of stainless steel accord-
ing to EN 1993-1-4 [3].

In the second tab of theNational Annex Settings dialog box, you can find the relevant Partial Factors
and Parameters for Stability Design.

Figure 2.13: Dialog box National Annex Settings - CEN, tab Stainless Steel (EN 1993-1-4)
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2.2 Materials

Thewindow is subdivided into two parts. The upper part lists all materials created in RFEM. TheMa-
terial Properties section shows the properties of the current material, that is, the table row currently
selected in the upper section.

Figure 2.14: Window 1.2Materials

Materials that will not be used in the design are dimmed. Materials that are not allowed are
highlighted in red. Modified materials are displayed in blue.

The material properties required for the determination of internal forces are described in Chap-
ter 4.3 of the RFEMmanual (Main Properties). Thematerial properties required for design are stored
in the global material library. These values are preset (Additional Properties).

You can adjust the units and decimal places of material properties and stresses using the menu
Settings → Units and Decimal Places (see Chapter 7.3, page 77).

Material Description
The materials defined in RFEM are preset, but you can always modify them: To do this, click
the material in column A. Then click or press function key [F7] to open the material list.

Figure 2.15: List of Materials

According to the design concept of the Standard [1], only materials of the Steel category are
available in the list.



2 Input Data

©Dlubal Software GmbH 2015

16

2
When you have imported a material, the design-relevantMaterial Properties are updated.

If you change the material description manually and the entry is stored in the material library,
RF-STEEL EC3 will import the material properties, too.

Generally, the material properties are not editable in the RF-STEEL EC3 add-on module.

Material Library
Numerous materials are already available in the library. To open the material library, click

Edit → Material Library

or use the button shown on the left.

Figure 2.16: Dialog boxMaterial Library

In the Filter section, the current Steelmaterial category is preset. Select the specific material in
theMaterial to Select list. You can check the corresponding properties in the dialog section below.

Click [OK] or use the [ ] button to transfer the selected material to Window 1.2 of RF-STEEL EC3.

Chapter 4.3 of the RFEM manual describes in detail how materials can be filtered, added, or re-
arranged.

In the library, you can also select materials of categories Cast Iron and Stainless Steel. Please check,
however, whether these materials are allowed by the design concept of the Standard [1].
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2.3 Cross-Sections

This window lists the cross-sections used for design. In addition, you can specify optimization
parameters here.

Figure 2.17: Window 1.3 Cross-Sections

Cross-Section Description
The cross-sections defined in RFEM are preset together with the assigned material numbers.

If you want to modify a cross-section, click the entry in column B. Click [Cross-Section Library] or
in the box or press function key [F7] to open the cross-section table of the current cross-section

box (see the following figure).

In this dialog box, you can select a different cross-section type. To select a different cross-section
category, click [Back to cross-section library] to access the general cross-section library.

Chapter 4.13 of the RFEMmanual describes how cross-sections can be selected from the library.
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Figure 2.18: IS cross-section types in the cross-section library

You can directly enter the new cross-section description in the input window. If the entry is listed
in the database, RF-STEEL EC3 imports these cross-section parameters, too.

A modified cross-section will be highlighted in blue.

If the cross-sections in RF-STEEL EC3 are different from the ones used in RFEM, both cross-sections
are displayed in the graphic on the right. The designs will be performed for the cross-section
selected in RF-STEEL EC3, using the internal forces from RFEM.

Cross-Section Type for Classification
The program displays a cross-section type that will be used for the classification. The cross-sec-
tions listed in [1], Table 5.2 can be designed plastically or elastically depending on the Class.
Cross-sections not included in this table are classified as General and can only be designed elasti-
cally (Class 3 or 4).

Classification
RF-STEEL EC3 performs the classification Automatically. If this is not desired, you can determine
the cross-section class manually using the drop-down list.

Max. Design Ratio
This column is displayed only after the calculation. It provides a decision support for the opti-
mization. By means of the displayed design ratio and colored relation scales, you can see which
cross-sections are little utilized and thus oversized, or overloaded and thus undersized.

Optimize
You can optimize every cross-section from the library: For the RFEM internal forces, the pro-
gram searches the cross-section that comes as close as possible to a user-defined maximum ratio.
You can define the maximum ratio in the Details dialog box, tab Others (see Figure 2.8, page 49).

If you want to optimize a cross-section, open the corresponding drop-down list in column D or E
and select the desired entry: From current row or, if available, From favorites 'Description'. Recom-
mendations for the cross-section optimization can be found in Chapter 7.2 on page 75.



2 Input Data

©Dlubal Software GmbH 2015

19

2
Remark
This column shows remarks in the form of footers that are explained below the cross-section list.

A warning might appear before the calculation: Incorrect type of cross-section! It means that there
is a cross-section that is not stored in the database. This may be a user-defined cross-section or
a SHAPE-THIN cross-section that has not been calculated yet. To select an appropriate cross-section
for the design, click the [Library] button (see description below Figure 2.17).

Member with Tapered Cross-Section
For taperedmembers with different cross-sections at themember start andmember end, themod-
ule displays both cross-section numbers in two rows, in accordance with the definition in RFEM.

RF-STEEL EC3 also designs tapered members, provided that the cross-section at the member start
has the same number of stress points as the cross-section at themember end. The normal stresses,
for example, are determined from themoments of inertia and the centroidal distances of the stress
points. If the cross-section at the start and the end of a tapered member have a different number
of stress points, the intermediate values cannot be interpolated. Then, the calculation is possible
neither in RFEM nor in RF-STEEL EC3.

The cross-section's stress points including numbering can also be checked graphically: Select
the cross-section in Window 1.3 and click the [Info] button. The dialog box shown in Figure 2.19
appears.

Info About Cross-Section
In the Info About Cross-Section dialog box, you can see the cross-section properties, stress points,
and c/t-parts.

Figure 2.19: Dialog box Info About Cross-Section

The buttons below the cross-section graphic have the following functions:
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Button Function

Display or hide the stress points

Display or hide the cross-section c/t-parts.

Display or hide the numbering of stress points or c/t-parts

Display the details of stress points or c/t-parts (see Figure 2.20)

Display or hide the cross-section dimensions

Display or hide the principal axes of the cross-section

Reset the full view of the cross-section graphic

Table 2.3: Buttons of cross-section graphic

Click [Details] to call up detailed information on stress points (centroidal distances, statical mo-
ments of area, warping constants etc.) and c/t-parts.

Figure 2.20: Dialog box Stress Points of HE B 260

If circumstances require it, you can change the buckling curves in the Cross-Section Properties
table of the 1.3 Cross-Sections window. This function is described in the following article of
the DLUBAL Blog: www.dlubal.com/blog/8684
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2.4 Intermediate Lateral Restraints

In Window 1.4, you can define intermediate lateral restraints for members. In RF-STEEL EC3, this
kind of support is always perpendicular to the minor z-axis of the cross-section (see Figure 2.19).
Thus, you can influence the members' effective lengths which are important for the stability
analysis of flexural buckling and lateral-torsional buckling (only for the Lateraland torsional restraint
type).

Figure 2.21: Window 1.4 Intermediate Lateral Restraints

In the upper part of the window, you can assign up to nine lateral restraints to each member.
The Settings section shows the entry in a column overview for the member selected above.

To define the intermediate restraints of a member, select the Lateral Restraints check box in col-
umn A. To graphically select the member, click . If you select the check box, the other columns
become available and you can enter the parameters.

In column B, you can select the Restraint Type from the drop-down list. The lateral and torsional
restraint is preset. Furthermore, you can place the intermediate restraints also at the lower or upper
flange. The User-defined restraint type allows you to individually specify the restraint parameters
in the Settings section (lateral support in the direction of the member axis y, restrained about
longitudinal member axis x, eccentricity of a restraint).

In column D, you can specify the Number of the intermediate restraints. Depending on the spec-
ification, one or more of the following Intermediate Lateral Restraints columns are available for
the definition of the x-locations.

If you select the Relatively (0 ... 1) check box, you can define the support points by relative input.
The positions of the intermediate restraints are determined by themember length and the relative
distances of the member start. If you clear the Relatively (0 ... 1) check box, it is possible to define
the distances manually in the upper table.
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In case of cantilevers, you should avoid intermediate restraints as they divide themember into seg-
ments. For cantilevered beams, this would result in segments with lateral and torsional restraints
(on one end each) that are statically underdetermined.

2.5 Effective Lengths - Members

The window is subdivided into two parts. The upper table includes summarized information
about the length factors of buckling, lateral-torsional and torsional-flexural buckling as well as
the equivalent lengths of the members to be designed. The effective lengths defined in RFEM are
preset. In the Settings section, you can see additional information about the member selected in
the upper section.

Click to select a member graphically and show its row.

You can make any changes in the upper table as well as in the Settings tree.

Figure 2.22: Window 1.5 Effective lengths - Members

The effective lengths for buckling about theminor z-axis are aligned automatically with the entries
of the 1.4 Intermediate Lateral Restraints window. If intermediate lateral restraints are dividing
the member into member segments of different lengths, the program displays no values in the ta-
ble columns G, K, and L of Window 1.5.

You can enter the effective lengths manually in the table and in the Settings tree, or define them
graphically in the work window by clicking the button. The button is active when you place
the cursor in the text box (see the figure above).

The Settings tree includes the following parameters:

• Cross-Section

• Length of the member

• Buckling possible for the member (cf. columns B, E and H)

• Buckling about Axis y Possible (cf. columns C and D)
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• Buckling about Axis z Possible (cf. columns F and G)

• Lateral-Torsional Buckling Possible (cf. columns I to K)

In this table, you can determine a buckling analysis or lateral-torsional buckling analysis to be
performed for the selected member. In addition, you can adjust the Effective Length Factor and
the Warping Length Factor for the respective lengths. If you modify the factor, the equivalent
member length is adjusted automatically, and vice versa.

You can also define the effective length of a member in a separate dialog box. To open it, click
the button shown on the left. It is located on the right below the upper table of the window.

Figure 2.23: Dialog box Select Effective Length Factor

For each direction, you can select one of the four Euler buckling modes or set the effective length
factor as User-defined. If the eigenvalue analysis has been performed in the RF-STABILITY add-on
module, you can import the Bucklingmode from there in order to determine the factor.

Buckling Possible
The stability analysis for flexural and lateral-torsional buckling requires compressive forces to be
included. Members for which this is not possible due to a member type (for example tension
members, elastic foundations, rigid couplings) are excluded from the analysis a priori. The corre-
sponding rows are dimmed and a note appears in the Comment column.

The Buckling possible check boxes in table row A and in the Settings tree allow you to control
the stability analyses: They determine whether the analyses for a member are or are not to be
performed.

Buckling About Axis y or Axis z
The Possible columns control if there is a buckling risk about the y-axis and/or z-axis. These axes
represent the local member axes, where the y-axis is the “major” and the z-axis is the “minor”
member axis. You can freely select the effective length factors kcr,y and kcr,z for buckling about
the major or the minor axis.

You can check the position of themember axes in the cross-section graphic in the 1.3 Cross-Sections
window (see Figure 2.17, page 17). To access the RFEMwork window, click the [ViewMode] button.
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There you can display the local member axes by using the member's shortcut menu or the Display
navigator.

Figure 2.24: Selecting the member axis system in the Display navigator of RFEM

If buckling is possible about one or even both member axes, you can enter the effective length
factors in columns C and F as well as the effective lengths in columns D and G. The same is possible
in the Settings tree.

To specify the effective lengths in the work window graphically, click . You can click the button
only if the cursor is placed in a Lcr text box (see Figure 2.22).

When specifying the effective length factor kcr, the program determines the effective length Lcr
by multiplying the member length L by the effective length factor. The text boxes kcr and Lcr are
interactive.

Axes definition for kz
and kw

Lateral-Torsional Buckling Possible
Column H shows which members are included in the analysis of lateral-torsional buckling.

To determineMcr by the eigenvalue calculationmethod, amember with four degrees of freedom is
created in the program background. You can define these degrees of freedom using the factors kz
and kw. Both factors determine the support conditions for lateral-torsional buckling (for example
a lateral and torsional restraint).

Effective Length Factor kz

The factor kz specifies the lateral restraint uy and the rotational restraint 𝜙z on member ends.

kz = 1.0 lateral restraint 𝑢𝑦 on both member ends

kz = 0.7le lateral restraint 𝑢𝑦 on both ends, restrained about 𝑧 on the left

kz = 0.7ri lateral restraint 𝑢𝑦 on both ends, restrained about 𝑧 on the right

kz = 0.5 lateral restraint 𝑢𝑦 , restrained about 𝑧 on both ends

kz = 2.0le lateral restraint 𝑢𝑦 , restrained about 𝑧 on the left; free end on the right

kz = 2.0ri lateral restraint 𝑢𝑦 , restrained about 𝑧 on the right; free end on the left
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Warping Length Factor kw

The factor kw specifies torsion 𝜙x about the member axis and the warping restraint 𝜔.
kw = 1.0 restrained about 𝑥 on both ends; free to warp on both ends

kw = 0.7le restrained about 𝑥 on both ends; warping restraint on the left

kw = 0.7ri restrained about 𝑥 on both ends; warping restraint on the right

kw = 0.5 torsion and warping restraint on both ends

kw = 2.0le restrained about 𝑥, warping restraint 𝜔 on the left; free to warp on the right

kw = 2.0ri restrained about 𝑥, warping restraint 𝜔 on the right; free to warp on the left

The abbreviations le and ri refer to the left and right side. The abbreviation le always describes
the support conditions at the member start.

You can model a lateral and torsional restraint using the factors kz = 1.0 (lateral restraint in y,
free torsion about z) and kw = 1.0 (restrained about x, free to warp). Since the internal member
model requires only four degrees of freedom, the definition of the other boundary conditions is
not necessary.

If the lateral-torsional length Lw or the torsional buckling length LT differs from the member or
buckling length, you can define the lengths Lw and LT manually in columns K and L or determine
them graphically using the button.

Comment
In the last column, you can enter your own comments for each member, for example to describe
the selected equivalent member lengths.

Set Input for Members No.
Under the Settings table, you find the Set input for members No. check box. If you select the check
box, the subsequent settings will be applied to the selected members or Allmembers (you can
enter themember numbersmanually or select themgraphically using the button). This option
is useful when assigning several members to the same boundary conditions (see also DLUBAL Blog
www.dlubal.com/blog/11115/).

With this function, you cannot subsequently change the settings already made before.
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2.6 Effective Lengths - Sets of Members

This window appears only if you selected at least one set of members for design in the 1.1 General
Data window (see Figure 2.2, page 44) and selected the Equivalent Member Method for sets of
members in the Details dialog box. If applied, Windows 1.7 and 1.8 will not be displayed. Then,
you can define the intermediate lateral restraints by using division points in Window 1.4.

Figure 2.25: Window 1.6 Effective Lengths - Sets of Members

The concept of the window is similar to the previous 1.5 Effective Lengths - Memberswindow. Here
you can enter the effective lengths for buckling about both principal axes of the set of members,
as described in Chapter 2.5.
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2.7 Nodal Supports - Set of Members

This window appears only if you have selected at least one set of members for the design in
the 1.1 General Datawindow.

The stability analysis for sets of members is usually carried out in compliance with the General
Method according to [1], Clause 6.3.4. However, if you select the EquivalentMemberMethod for sets
of members in the Details dialog box (see Figure 2.2, page 44), Window 1.7 will not be displayed.
Then, you can define the intermediate lateral restraints by using division points in Window 1.4.

Figure 2.26: Window 1.7 Nodal Supports - Set of Members

The current tablemanages theboundary conditionsof the set ofmembers selected in thenavigator
on the left!

The supports defined in RFEM, such as the supports in Z of a continuous beam, are not relevant in
this window. The program imports the distributions of moments and shear forces for determina-
tion of amplification factor automatically from RFEM. You can define several support conditions
here that have an impact on stability failure (buckling, lateral-torsional buckling).

Supports on the start and end nodes of a set of members are preset. Any other supports, for
example as a result of additional members, has to be added manually. You can select nodes
graphically in RFEM work window using the button.

According to [1], Clause 6.3.4 (1), you can design monosymmetrical cross-sections that are loaded
solely in their principal plane. For this analysis method, it is necessary to know the amplification
factor 𝛼cr,op of the entire set of members. In order to determine this factor, the program creates
a planar framework with four degrees of freedom for each node.

The axes orientation in a set of members is important for the definition of nodal supports. The pro-
gram checks the position of nodes and internally defines the axes of nodal supports forWindow1.7,
according to Figure 2.27 to Figure 2.30. The [Local Coordinate System] button below the model
graphic can help you with the orientation. With this button, you can display the set of members in
a partial view where the axes are clearly visible (see DLUBAL Blog www.dlubal.com/blog/9763).
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Figure 2.27: Auxiliary coordinate system of nodal supports - straight set of members

If all members of a set of members rest on a straight line, as shown in the Figure 2.27, the local
coordinate system of the first member in the set of members corresponds to the equivalent
coordinate system of the entire set of members.

Figure 2.28: Auxiliary coordinate system of nodal supports - set of members on vertical plane

If members of a set of members do not rest on a straight line, they still have to be located in
the same plane. In Figure 2.28, the members rest on a vertical plane. In this case, the X′-axis is
horizontal and it is oriented in the direction of the plane. The Y’-axis is horizontal as well and
defined as perpendicular to the X′-axis. The Z′-axis is oriented perpendicularly downwards.

Figure 2.29: Auxiliary coordinate of nodal supports - set of members on horizontal plane

If members of a buckled set of members rest on a horizontal plane, the X′-axis is defined parallel to
the X-axis of the global coordinate system. Thus, the Y′-axis is oriented in the opposite direction
to the global Z-axis and the Z′-axis is directed parallel to the global Y-axis.

Figure 2.30: Auxiliary coordinate system of nodal supports - set of members on inclined plane

Figure 2.30 shows the general case of a buckled set of members: The members do not rest on
a straight line, but on an inclined plane. The definition of the X′-axis results from the intersection
line between the inclined plane and the horizontal plane. Thus, the Y′-axis is perpendicular to
the X′-axis and directed perpendicularly to the inclined plane. The Z′-axis is defined perpendicular
to the X′-axis and Y′-axis.
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The buttons below the graphic have the following functions:

Button Function

Display the model or the system sketch

Display the members as a 3D rendering or a wireframe model

Display the current set of members or the entire model

Display the irrelevant members of the model transparent or opaque

Display the set of members in the local coordinate system or the entire model

Show the view in the direction of the X-axis

Show the view against the Y-axis

Show the view in the direction of the Z-axis

Display the isometric view

Table 2.4: Buttons of cross-section graphic

Click the [Edit warp stiffener and import the warp spring] button to determine the constant of
a warp spring.

Figure 2.31: Dialog box Edit Warp Spring

In the Edit Warp Spring dialog box, you can select one of the following types of warp springs:

• End plate

• Channel section

• Angle

• Connecting column

• Cantilevered portion

You can select the materials and cross-sections using the lists and [Library] buttons. Click the
button for a graphical selection in the RFEMmodel.

RF-STEEL EC3 determines the Resulting warp spring Cu� from the parameters and then imports
the result in Window 1.7 by clicking [OK].
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2.8 Member Hinges - Set of Members

This window appears only if you have selected at least one set of members for the design in
the 1.1 General Data window. In this window, you can define hinges for members and sets of
members that do not transfer locked degrees of freedom specified inWindow 1.7 as internal forces
for structural reasons. Please note, that no double hinges are generated in the interaction with
Window 1.7.

The table manages the hinge parameters of a set of members selected in the navigator on the left.

If the Equivalent Member Method is selected in the Details dialog box (see Figure 2.2, page 44),
Window 1.8 is not displayed. You can define intermediate lateral restraints by using division points
in Window 1.4.

Figure 2.32: Window 1.8Member Hinges - Set of Members

ColumnB shows theMember Sideonwhich a hinge is located or if there are hinges onbothmember
sides.

In columns C to F, you can define hinges or spring constants to adjust the set of members model
to the support conditions in Window 1.7.
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2.9 Serviceability Data

This input window controls various settings for the serviceability limit state design. The window is
available only if you have entered the corresponding data in the Serviceability Limit State tab in
Window 1.1 (see Chapter 2.1.2, page 10).

Figure 2.33: Window 1.9 Serviceability Data

Column A shows if the deformation refers to single members, lists of members, or to sets of
members.

Column B shows the numbers of members or sets of members to be designed. You can select
the numbers graphically in the RFEMworkwindow using the button. Then, the Reference Length
automatically appears in column D. You can define the valuesManually if you select the check box
in column C.

In column E, you can define the governing Direction for the deformation analysis. You can select
the directions of the local member axes y and z (or u and v for unsymmetrical cross-sections).

In column F, you can consider a Precamberwc.

For the correct application of limit deformations, the Beam Type is especially crucial. In column G,
you can specify whether a beam or a cantilever is to be designed and which end is free of support.

The setting in the Serviceability tab of the Details dialog box indicates whether the deformations
are related to the undeformed system or to shifted members ends / set of members ends (see
Figure 2.3, page 46).
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2.10 Fire Resistance - Members

This input window includes the fire resistance parameters. It appears only if you have entered
the corresponding data in the Fire Resistance tab of Window 1.1 (see Chapter 2.1.3, page 11).

Figure 2.34: Window 1.10 Fire Resistance - Members

Column A contains the members considered in the fire resistance design. Click to graphically
select the members in the RFEM work window.

It is possible to perform analyses only for members selected for design in the 1.1 General Data
window (see Figure 2.2, page 7).

In column B, you can define the number of cross-section sides exposed to fire. The Fire Exposure
affects the determination of the section factors according to [2], Table 4.2 and Table 4.3.

If there is an encasement for fire resistance, you can select the Protection Type in columnD. You can
choose between a contour encasement, following the geometry of the cross-section (for exam-
ple intumescent coating) and a hollow encasement of the cross section. Then, you can specify
the corresponding parameters in columns E to H.

The general parameters for the fire resistance design are managed in the Fire Resistance tab of
the Details dialog box (see Figure 2.4, page 47).

The fire resistance design in RF-STEEL EC3 is described in the following article of DLUBAL Blog:
www.dlubal.com/blog/1242
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2.11 Fire Resistance - Sets of Members

This window appears only if you have selected at least one set ofmembers for design in the 1.1Gen-
eral Data window and entered the corresponding data in the Fire Resistance tab of Window 1.1
(see Chapter 2.1.3, page 11).

Figure 2.35: Window 1.1 Fire Resistance - Sets of Members

The concept of thewindow is similar to theprevious 1.10 FireResistance -Memberswindow. You can
enter the fire protection parameters of the corresponding sets of members, as described in Chap-
ter 2.10.
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2.12 Parameters - Members

This window allows you to enter specifications for beams that are laterally supported by sheeting
or purlins (see [6], Clause 10.1 and 10.3).

The upper section lists the members selected for design together with the parameters relevant
for the lateral-torsional buckling design. These parameters interact with the specifications in
the Settings - Member No. section below.

To the right of the Settings table, you can see information or selecting options in the form of
graphics facilitating the definition of boundary conditions. The views vary depending on the
currently selected parameter.

Figure 2.36: Window 1.12 Parameters - Members

Below the Settings table, there is the Set input for members No. check box. If selected, the sub-
sequent settings applies to the selected members or Allmembers (you can enter the member
numbers manually or select them graphically using the button). This option is useful when
assigning several members to the same boundary conditions.

In the Comment column, you can enter user-defined comments for each member, for example to
describe a member's parameters relevant for lateral-torsional buckling.

Cross-Section
This column shows the cross-sectiondescription. For a taperedmember, thedescriptionof the start
and end cross-section is displayed.
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Shear Panel
To enter the shear panel parameters, select the check box in column A or in the Settings table.

You can select the shear panel type in the drop-down list.

Figure 2.37: Selecting shear panel type

Trapezoidal sheeting

The application of a continuous lateral support is described in EN 1993-1-1 [1], Annex BB.2.1 and
EN 1993-1-3 [6], Clause 10.1.5.1.

To determine the shear panel stiffness of a trapezoidal sheeting (corrugated sheet), the following
specifications are required (see Figure 2.36):

• Shear panel length lS

• Beam spacing s

• Position of trapezoidal sheeting on section

• Trapezoidal sheeting description

• Fastening arrangement

You can enter the Shear panel length and the Beam spacingmanually or select them graphically
by clicking . This button becomes available when the cursor is placed in one of these text
boxes. Then, you can select two snap points in the RFEM work window defining the shear panel
or the beam spacing.

The Position on section of the trapezoidal sheeting can be considered in different ways by means
of the list shown on the left. The selected point of torsion D is marked in the cross-section graphic,
even for user-defined entries. The distance d is relative to the centroid here; the sign results from
the z-axis of the cross-section.

To access the corrugated sheets library, click the button displayed after you click in the Trape-
zoidal sheeting description text box (see Figure 2.36). The RFEM cross-section library appears (see
Figure 2.38), where you can select the trapezoidal sheeting by double-clicking or clicking [OK].
Thus, the shear panel coefficients K1 and K2 (according to the approval certificate) are automatically
entered in the Settings table. The basic width b of the trapezoidal sheeting has no influence on
these coefficients.

The Fastening arrangement of the trapezoidal section affects the shear stiffness that the sheeting
provides to the beam. If the trapezoidal sheeting is fastened only in every second rib, the shear
stiffness to be applied is reduced by a factor of 5.
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Figure 2.38: Cross-section library Rolled Cross-Sections - Corrugated Sheets

Bracing

Figure 2.39: Shear panel type Bracing

To determine the provided shear panel stiffness, the following specifications are required:

• Shear panel length lS

• Beam spacing s

• Position of the bracing on section

• Post spacing b

• Number of bracings

• Section of diagonals

• Section of posts
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You can enter the Shear panel length, the Beam spacing, and the Post spacingmanually or select
it graphically by clicking . This button becomes available when the cursor is placed in one of
these text boxes. Then, you can select two points in the RFEMwork window, defining the shear
panel or the spacing.

The bracing's Position on section can be considered in different ways using the list shown on
the left. The selected point of torsion D is marked in the cross-section graphic, even for user-de-
fined entries. The distance d is relative to the centroid here; the sign results from the z-axis of
the cross-section.

You can easily define the cross-sectional area of the diagonals and posts by selecting the Section
Description in the RFEM library. To access the library, click the button at the end of the text box.
Then, the CS-Area is imported automatically. You can also enter the value directly.

Trapezoidal sheeting and bracing

Figure 2.40: Shear panel type Trapezoidal sheeting and bracing

To determine the provided shear panel stiffness due to trapezoidal sheeting and bracing, the fol-
lowing specifications are required:

• Shear panel length lS

• Beam spacing s

• Position of shear panel on section

• Trapezoidal sheeting description

• Fastening arrangement

• Post spacing b

• Number of bracings

• Section of diagonals

• Section of posts

This way of defining the shear panel combines the parameters of the aforementioned options
Trapezoidal sheeting and Bracing.
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Defining S-prov

Figure 2.41: Defining shear panel stiffness Sprov

You can also enter the value of the provided Shear panel stiffness Svorh directly. In addition, you
have to specify the shear panel's Position on section.

Rotational Restraint
To enter the rotational restraint parameters, select the check box in column B or in the Settings
table.

You can select the type of rotational restraint in the drop-down list.

Figure 2.42: Selecting the type of rotational restraint

Continuous rotational restraint

In order to determine the stiffness components from trapezoidal sheeting and the connection
deformation, the following specifications are necessary (see Figure 2.42):

• Material and description of the trapezoidal sheeting

• Method of determining CD,A

• Beam spacing s

• Continuous beam effect

To access the corrugated sheet library, click the button displayed after you click in the Com-
ponent description text box. The RFEM cross-section library appears (see Figure 2.38, page 36),
where you can select a corrugated sheet by double-clicking or clicking [OK]. The section parame-
ters Sheeting thickness t, Position of sheeting, effective Secondmoment of area Is for the downward
loading direction, Distance of ribs bR (corrugation width), andWidth of the flange bT are imported
automatically.

In the case of continuous rotational restraint, you have to consider the deformation of the con-
nection. You can specify the rotational spring stiffness C100 for the individual load cases and
combinations in theMethod of determining CD,A entry, or the program determines it according
to [6], Table 10.3. For automatic calculation, click the button shown after clicking in the text box
of the row C100. A dialog box appears where you can select the appropriate coefficient.
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Figure 2.43: Dialog box Import of Coefficient C-100 from Table 10.3, EN 1993-1-3

Click [OK] to assign this value to all load cases and combinations selected for the design. In order
to assign the coefficient by load case, you have to open the Import of Coefficient dialog box via
the C100 text boxes of the individual load cases and combinations.

You can also define the Beam spacingmanually or graphically by clicking the button. For this,
click two nodes in the RFEM work window defining the distance between the beams.

The Continuous beam effect has an impact on the coefficient k of the rotational restraint CD,C,
definable by means of the list in this row (End panel: k = 2, Internal panel: k = 4).

Discrete rotational restraint

Figure 2.44: Type of rotational restraint Discrete
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In order to determine the stiffness component from isolated columns (for example purlins), the fol-
lowing specifications are required:

• Material and description of the cross-section

• Purlin spacing e

• Beam spacing s

• Continuous beam effect

Material and Cross-section description can be selected from the RFEM library using the button.
Select the relevant text box and click in it.

You can enter the Purlin spacing and the Beam spacingmanually or graphically by clicking the
button. For this, select two nodes defining the spacing of the purlins or beams by clicking them in
the RFEM work window.

The Continuous beam effect has an impact on the coefficient k of the rotational restraint CD,C,
definable by means of the list in this row (End panel: k = 2, Internal panel: k = 4).

DefineManually

Figure 2.45: Rotational Spring Stiffness - DefineManually

You can also directly enter the existing Total Rotational Spring Stiffness CD .

Cross-Sectional Area for Tension Design

Figure 2.46: Cross-sectional area for tension design

According to [1], Clause 6.2.3, holes for fasteners are considered in tensile stress design. You can
define theNetCross-Sectional AreaAnet separately for the Start and End of themember - fasteners
are usually located at these two x-locations. The table also shows the gross cross-sectional area A.
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2.13 Parameters - Sets of Members

This window appears only if you have selected at least one set of members for the design in
the 1.1 General Datawindow.

Figure 2.47: Window 1.13 Parameters - Sets of Members

The concept of this window is similar to the previous 1.12 Parameters - Memberswindow. In this
window, you can define the parameters of shear panels and rotational restraints for each set of
members as described in Chapter 2.12.
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3 Calculation

3.1 Detail Settings

Before you start the calculation, it is recommended to check the design details. You can access
the corresponding dialog box in all windows of the add-on module by using the [Details] button.

The Details dialog box has the following tabs:

• Ultimate Limit State

• Stability

• Serviceability

• Fire Resistance

• Other

3.1.1 Ultimate Limit State

Figure 3.1: Dialog box Details, tab Ultimate Limit State
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Classification of Cross-Sections
If stresses from compression and bending occur together in a cross-section, you can determine
the stress deformation ratio 𝜓 with regard to the compression zone factor 𝛼 in two ways (the fac-
tor 𝜓 is required for the determination of the appropriate c/t-ratio according to [1], Table 5.2):

• Fixed NEd, increaseMEd to reach fyd
Only the flexural stress component is increased to reach the yield strength.

• Increase NEd andMEd uniformly
The flexural stress components from axial force and bending are increased uniformly until
the yield strength fyd is reached.

The For limit c/t of Class 3, increasematerial factor 𝜀 acc. to 5.5.2(9) check box appears if the stability
analysis hasbeendeactivated in the Stability tab. This is basedon the specifications for classification
in [1], Clause 5.5.2 (10). If the stability analysis is deactivated you can consider the cross-sections
classified as Class 4 for cross-sections of Class 3 by increasing the factor 𝜀.

If you select the Use SHAPE-THIN for Classification of all supported cross-section types check box,
the effective cross-section properties of Class 4 sectionswill be calculated according to themethod
used in SHAPE-THIN. For cross-sections classified as 'General' (that is, they belong neither to
a rolled nor a parametrized cross-section table), the classification will be generally performed
with SHAPE-THIN. You can design these cross-sections only elastically as Class 3 or Class 4 cross-sec-
tions.

Optionally, you can Determine effective widths according to EN 1993-1-5, Annex E. [7], Annex E
describes the alternative methods for determining effective cross-section areas for stresses below
the yield strength (see also DLUBAL Blog www.dlubal.com/blog/5535).

The width/thickness ratios relevant for the classification could cause problems with section in case
of SHAPE-THIN curved elements. Using the Ignore classification of curved parts check box, you can
exclude short fillet arcs from the classification once the user-defined c/t-ratio is below the limit
(see DLUBAL Blog www.dlubal.com/blog/11166). Longitudinal ribs or slopes of thin sheetings has
no influence on the design.

Options
Cross-sections assigned to Class 1 or 2 are designed plastically in RF-STEEL EC3. If you do not want
to perform a plastic design, you can activate the Elastic Design also for these cross-section classes.

Stability Analyses with Second-Order Internal Forces
If the stability analyses are not performed with the equivalent member method according to [1],
Clause 6.3, but with second-order internal forces , you can use this check box to specify whether
to use the partial safety factor 𝛾M1 (instead of 𝛾M0) for the cross-section design.

The partial safety factor 𝛾M1 is relevant for the resistance determination in case of instability (struc-
tural component check). You can check and/or modify the safety factor in the National Annex
Settings dialog box (see Chapter 3.10, page 12).

Cross-Section Check for M+N
The Use linear interaction acc. to 6.2.1(7) check box determines whether to use the linear addition
of the utilization ratios for the moments and axial forces according to [1], Eq. (6.2), or Eq. (6.44) as
conservative approximation for the resistance verification of the cross-section.
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3.1.2 Stability

Figure 3.2: Dialog box Details, tab Stability

Stability Analysis
The Perform stability analysis check box controls whether to run a stability analysis in addition to
the cross-section designs. If you clear the check box, the Windows 1.4 to 1.8 will not appear.

If you select the check box, you can define the axes relevant for the determination of Flexural
buckling according to 6.3 of [1].

In addition, you can Include second-order effects acc. to 5.2.2(4) by increasing bendingmoment about
an axis that you can define manually. In this way, when designing for example a frame with gov-
erning buckling mode represented by lateral displacement, you can determine the internal forces
according to linear static analysis and increase them with the appropriate factors. The bending
moment increment has no effect on the flexural-buckling analysis according to [1], Clause 6.3.1,
which is performed by using the axial forces.
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Determination of Elastic Critical Moment for LTB
By default, RF-STEEL EC3 determines the elastic critical moment for lateral-torsional buckling
Automatically by EigenvalueMethod. For the calculation, the program uses a finite member model
to determineMcr with regard to the following items:

• Dimensions of gross cross-section

• Load type and position of load application point

• Effective distribution of moments

• Lateral restraints (by support conditions)

• Effective boundary conditions

You can specify the degrees of freedom by the factors kz and kw (see Chapter 2.5, page 22).

You can also determine the elastic critical moment Automatically by comparison ofmoment distribu-
tion and assignment of the coefficient C1. Click the [Info] button to open the corresponding dialog
box and view the load and moment distributions. The coefficients C2 and C3 will be determined
automatically by the Eigenvalue Method, if required.

Mcr user-defined

Select theManual definition inWindow 1.5 check box to change the name of column J toMcr, so
you can directly enter the elastic critical moment for LTB.

If there are transverse loads, it is necessary to define the location where these forces are acting on
the cross-section: Depending on the load application point, transverse loads can be stabilizing or
destabilizing, and thus influence the elastic critical moment.

Model Type According to Table B.3
According to [1], Annex B, Table B.3, the equivalent uniformmoment factor for structural compo-
nents with buckling in the form of lateral deflection should be taken as Cmy = 0.9 or Cmz = 0.9.
Both check boxes are cleared by default. If you select the check boxes, the program determines
the factors Cmy and Cmz according to the criteria defined in Table B.3.

Limit Values for Special Cases
To design unsymmetric cross-sections with the intended axial compression according to [1],
Clause 6.3.1, you can neglect smallmoments about themajor and theminor axes using the settings
defined in this dialog box section.

For the pure check of bending according to [1], Clause 6.3.2, you can similarly neglect small com-
pression forceswhere the limit ratio of Nc,Ed / Npl is defined.

According to [1], Clause 6.3.4, the design of Unsymmetric Cross-Sections, TaperedMembers or Sets of
Members is only possible for uniaxial bending in the principal plane and/or compression. In order
to neglect the small moments about the minor axis, you can define a limit for the moment ratios
Mz,Ed /Mpl,z,Rd.

The intended torsion is not clearly specified in [1]. If there is a torsional stress not exceeding
the shear stress ratio of 5 % preset by default, it is not considered in the stability design; only
results for flexural and lateral-torsional buckling are displayed.

If one of the limits in this dialog section is exceeded, a note appears in the result window and no
stability analysis is performed. However, the cross-section designs are performed independently.
These limit settings are not part of the Standard [1] or anyNational Annex. Modification of the limits
is in the user's responsibility.
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Stability Analysis Method of Sets of Members
The stability behavior of sets of members can be analyzed according to two methods.

According to 6.3.1 ... 6.3.3 (EquivalentMemberMethod), it is possible to treat sets of members as one
large member. For this, define the factors kz and kw in the 1.6 Effective Lengths - Sets of Members
window. These factors are used to determine the support conditions 𝛽 , uy,𝜑x,𝜑z, and𝜔. If applied,
Windows 1.7 and 1.8 will not be displayed. Please note that the factors kz and kw are identical for
each section or member of the set of members. In general, you should use the equivalent member
method only for straight sets of members.

If you select 6.3.4 (General Method), the program performs a general analysis according to [1],
Clause 6.3.4, based on the coefficient 𝛼cr. In the 1.7 Nodal Support - Set of Memberswindow, you
can define the support conditions with regard to the stability failure (buckling and lateral-torsional
buckling) for each set of members individually. The factors kz and kw from Window 1.5 are not
used.

3.1.3 Serviceability

Figure 3.3: Dialog box Details, tab Serviceability

Deformation Relative To
These options specify whether the maximum deformations are relative to the shifted members
ends / set of members ends (connection line between start and end nodes of a deformed system)
or to the undeformed initial system. Generally, the deformations are designed as relative to
the displacements in the entire structural system.

You can check and, if necessary, adjust the limit deformations in the National Annex Settings dialog
box (see Figure 3.10, page 12).
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Limitation of Web Breathing
In the case of the serviceability limit state design of steel bridges, it is necessary to check the slen-
derness ratio of web plates in order to avoid excessive rippling and breathing of plates as well
as stiffness reductions due to plate buckling. The Design as steel bridge structure according to
EN 1993-2, 7.4 [8] check box allows you to analyze the breathing (repeated out-of-plane deforma-
tion), which can result in fatigue problems at the web-to-flange connections.

It is necessary to define whether you design a Road bridge or a Railway bridge as there are different
criteria for each case.

3.1.4 Fire Resistance

In this tab, you can control detail settings for the fire resistance design.

Figure 3.4: Dialog box Details, tab Fire resistance

In order to determine the temperature change, you should define the Required timeof fire resistance
and the Time interval of analysis aswell as the TemperatureCurve forDeterminationof Temperatureof
Gases. You can select one of three nominal temperature curves illustrated in Figure 3.5 to Figure 3.7
on the next page.

The Factors for determination of net heat flux are preset in accordance with [9] and [2]. However,
you can adjust them according to specific conditions.

If you select the Define final temperature manually check box, then it is possible to individually
define the temperature 𝛩a in Window 1.10 and 1.11.
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Figure 3.5: Standard temperature-time curve

Figure 3.6: External fire curve

Figure 3.7: Hydrocarbon curve
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3.1.5 Other

Figure 3.8: Dialog box Details, tab Other

Cross-Section Optimization
By default, the optimization is targeted on the maximum allowable design ratio of 100 %. If neces-
sary, you can set a different design ratio in this text box.

Check of Member Slendernesses
In both text boxes, you can specify the limit value 𝜆limit in order to define member slendernesses.
You can enter specifications separately for members with tension forces only and for members
with flexure and compression.

The limit values are compared to the realmember slendernesses inWindow3.3. This result window
is available after the calculation (see Chapter 4.8, page 59), if you have selected the corresponding
check box in the Display Result Tables dialog box section.

Design of Welds
If you select this check box, the weld designs are performed in the course of the analysis.
The program performs the typical designs according to EN 1993-1-8 [10]. After the calculation,
you can find the results under the cross-section designs (see also the following DLUBAL Blog:
www.dlubal.com/blog/3675).
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Display Result Windows
In this dialog section, you can select which result windows including the parts list should be
displayed. These windows are described in Chapter 4 - Results.

The 3.3Member Slendernesseswindow is deactivated by default.

3.2 Start Calculation
In all input windows of the RF-STEEL EC3 add-on module, you can start the calculation using
the [Calculation] button.

RF-STEEL EC3 searches for the results of the load cases, load combinations and result combinations
to be designed. If they cannot be found, the program starts the RFEM calculation to determine
the design-relevant internal forces.

You can also start the calculation in the RFEM user interface: The To Calculate dialog box (menu
Calculate → To Calculate) lists design cases of the add-on modules like load cases and load
combinations.

Figure 3.9: Dialog box To Calculate

If the RF-STEEL EC3 design cases are missing in the Not Calculated section, select All or Add-on
Modules in the drop-down list below the section.

Use the button to transfer the selected RF-STEEL EC3 cases to the list on the right. Click [OK]
to start the calculation.

To calculate a design case directly, use the list in the toolbar. Select the RF-STEEL EC3 design case
in the toolbar list and click [Show Results].

Figure 3.10: Direct calculation of a RF-STEEL EC3 case in RFEM

Subsequently, you can see the design process in a separate dialog box.
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4 Results
Chapter 4 - Results describes the different results windows one by one. The evaluation of and
checking results is described in Chapter 5 - Results Evaluation, page 63 ff.

The 2.1 Design by Load Casewindow appears immediately after the calculation.

Figure 4.1: Result window with designs and intermediate values

The designs are shown in the result windows 2.1 to 2.5, sorted by different criteria.

Windows 3.1 and 3.2 list the governing internal forces, Window 3.3 gives information on member
slendernesses. The last two Windows 4.1 and 4.2 show the parts lists by member and set of
members.

Every window can be selected by clicking the corresponding entry in the navigator. To set the pre-
vious or next window, use the buttons shown on the left. You can also use the function keys to
select the next [F2] or previous [F3] window.

[OK] saves the results. RF-STEEL EC3 is closed and you return to the main program.
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4.1 Design by Load Case

The upper part of the window shows a summary of the governing designs, sorted by load case,
load combination, and result combination. Furthermore, the list is divided in ultimate limit state
design, serviceability limit state design, and fire resistance design.

The lower part includes detailed information on the cross-section properties, analyzed internal
forces, and design parameters for the load cases selected above.

Figure 4.2: Window 2.1 Design by Load Case

Description
This column shows the descriptions of the load cases, load combinations, and result combinations
used for the designs.

Member No.
This column shows the number of the member with the maximum design ratio of the designed
actions.

Location x
This column shows the respective x-location where the member's maximum design ratio occurs.
For the table output, the program uses the following member locations x:

• Start and end node

• Division points according to possibly defined member division (see RFEM Table 1.16)

• Member division according to specification for member results (Calculation Parameters dialog
box, Global Calculation Parameters tab in RFEM)

• Extreme values of internal forces
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Design Ratio
Columns D and E show the design conditions according to [1], [2] and [3]. The length of colored
bars represents the respective design ratios.

Design According to Formula
This column displays the code's equations by which the designs have been performed.

DS
The last column provides information on the respective check-relevant design situations (DS): PT
or AC for the ultimate limit state or one of three design situations for serviceability (CH, FR, QP)
according to the specifications in the 1.1 General Datawindow (see Figure 4.7, page 10).

4.2 Design by Cross-Section

Figure 4.3: Window 2.2 Design by Cross-Section

In this result window, the maximum design ratios of all members and actions selected for design
are listed by cross-section. The results are sorted by cross-section design and stability analysis as
well as serviceability limit state design and fire resistance design.

If there is a tapered member, the cross-sections of the member start and end are listed separately.
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4.3 Design by Set of Members

Figure 4.4: Window 2.3 Design by Set of Members

This result window is displayed if you have selected at least one set of members for the design.
The window lists the maximum design ratios sorted by set of members.

The columnMember No. shows the number of the one member within the set of members that
bears the maximum stress ratio for the respective design criteria.

Theoutputby set ofmembers clearly presents thedesign for anentire structural group (for example
a frame joint).
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4.4 Design byMember

Figure 4.5: Window 2.4 Design byMember

This result window shows the maximum design ratios for individual designs sorted by member
number. The columns are described in detail in Chapter 4.1 on page 52.
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4.5 Design by x-Location

Figure 4.6: Window 2.5 Design by x-Location

This result window lists the maxima for each member at all locations x, resulting from the division
points defined in RFEM:

• Start and end node

• Division points according to possibly defined member division (see RFEM Table 1.16)

• Member division according to specification for member results (Calculation Parameters dialog
box, Global Calculation Parameters tab in RFEM)

• Extreme values of internal forces
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4.6 Governing Internal Forces byMember

Figure 4.7: Window 3.1 Governing Internal Forces byMember

For each member, this window displays the governing internal forces, that is, the internal forces
that result in the maximum utilization in each design.

Location x
This column shows the respective x-location where the member's maximum design ratio occurs.

Loading
This column shows numbers of the load case as well as load and result combination with internal
forces resulting in the maximum design ratio.

Forces / Moments
For each member, this column displays the axial and shear forces as well as the torsional and
bendingmoments producing themaximum ratios in the respective cross-section designs, stability
analyses, serviceability limit state designs, and fire resistance designs.

Design According to Formula
The last column shows the design types and equations used for the designs according to [1], [2],
or [3].
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4.7 Governing Internal Forces by Set of Members

Figure 4.8: Window 3.2 Governing Internal Forces by Set of Members

For each set of members, this window shows the internal forces that result in the maximum ratios
of the design.
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4.8 Members Slendernesses

Figure 4.9: Window 3.3Member slendernesses

This result window appears only if you have selected the respective check box in the Details dialog
box, tab Other (see Figure 4.8, page 49).

The table lists the effective slendernesses of the designed members for both directions of the prin-
cipal axes. They are determined in compliance with the load type. At the end of the list, there is
a comparison with the limit values that have been defined in the Details dialog box, tab Other (see
Figure 4.8, page 49).

Members of the "Tension" or "Cable" type are not included in this window.

This window is only of an informative character. It provides no stability analysis of slendernesses.
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4.9 Parts List byMember

Finally, there is a summary of all cross-sections included in the design case.

Figure 4.10: Window 4.1 Parts List byMember

By default, this list contains only the designed members. If you need a parts list for all members
of the model, select the corresponding option in the Details dialog box, tab Other (see Figure 4.8,
page 49).

Part No.
The program automatically assigns part numbers to similar members.

Cross-Section Description
This column lists the cross-section numbers and descriptions.

Number of Members
This column shows howmany similar members are used for each part.

Length
This column shows the respective length of an individual member.

Total Length
This column shows the product determined from the two previous columns.
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Surface Area
For each part, the program indicates the surface area relative to the total length. The surface area
is determined from the Surface of the cross-sections that can be seen inWindows 1.3 and 2.1 to 2.5
in the cross-section properties (see Figure 4.19, page 19).

Volume
The volume of a part is determined from the cross-sectional area and the total length.

Unit Weight
The Unit Weight of the section is relative to the length of one meter. For tapered cross-sections,
the program averages both cross-section weights.

Weight
Thevaluesof this columnaredetermined fromthe respectiveproductof theentries in columnsCandG.

Total Weight
The final column indicates the total weight of each part.

Sum
At the bottom of the list, you find a summary of the values in the columns B, D, E, F, and I. The last
row of the Total Weight column shows the total amount of required steel.

4.10 Parts List by Set of Members

Figure 4.11: Window 4.2 Parts List by Set of Members

The last result window is displayed if you have selected at least one set of members for design.
The window summarizes an entire structural group in a parts list, for example horizontal beams.
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Details on the various columns can be found in the previous chapter. If there are different
cross-sections used in a set of members, the program averages the surface area, the volume
and the cross-section weight.
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5 Results Evaluation
You can evaluate the design results in different ways. For this, you can use the buttons below
the upper table.

Figure 5.1: Buttons for results evaluation

The buttons have the following functions:

Button Description Function

Ultimate Limit State Designs Display or hide the results of ULS design

Serviceability Limit State Designs Display or hide the results of SLS design

Fire Protection Designs
Display or hide the results of the fire protection
design

Result Combination
Create a new result combination from the
governing load cases and load combinations

Color Bars
Display or hide the colored relation scales in
the result windows

Filter Parameter
Describe the criterion for filtering results in
tables: ratios greater than 1, maximum or
user-defined limit

Apply Filter
Display only the rows with applied filter
parameter (design ratio > 1, maximum,
user-defined limit)

Result Diagrams
Open the Result Diagram onMemberwindow
→ Chapter 5.2, page 67

Excel Export
Export the table to MS Excel / OpenOffice →
Chapter 7.4.3, page 78
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Member Selection
Select a member graphically to display its
results in the table

View Mode
Jump to the RFEM work window to change
the view

Table 5.1: Buttons in the result windows 2.1 to 2.5

When evaluating the fire resistance design, you can check the steel temperature development
graphically: Click the button shown on the left (below the cross-section graphic in the result
window) to open the Temperature Curves diagram, as shown in Figure 5.5 to Figure 5.7, page 48.

5.1 Results in RFEMModel

You can also evaluate the design results in the RFEM work window.

RFEM background graphic and viewmode
The RFEM work window in the background is useful when you want to find the position of a
particular member in the model: The member selected in the result window of RF-STEEL EC3 is
highlighted in the selection color in the background graphic. An arrow indicates also themember's
x-location that is displayed in the active table row.

Figure 5.2: Indication of member and current Location x in the RFEMmodel

In case you cannot improve the display by moving the RF-STEEL EC3 module window, click [Jump
to Graphic] to activate the View mode: The program hides the window so that you can modify
the display in the RFEM user interface. The viewmode provides the functions of the Viewmenu,
for example zooming, moving, or rotating the display. The pointer remains visible.

Click [Back] to return to the RF-STEEL EC3 add-on module.
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RFEMwork window
You can graphically check the design ratios in the RFEMmodel: Click [Graphics] to exit the design
module. In the RFEM work window, the design ratios are now displayed like the internal forces of
a load case.

In the Results navigator, you can specify which design ratios of the serviceability and ultimate limit
state or fire resistance design you want to display in the graphic.

Figure 5.3: Results navigator for Ultimate limit state, Serviceability and Fire resistance

To turn the display of design results on or off, click the [Show Results] button, that you know from
the display of internal forces in RFEM. To display the result values, click the [Show Values] button
on the right.

The RFEM tables are not relevant for the evaluation of the design results.

You can set the design cases by means of the list in the RFEMmenu bar.

To adjust the graphical representation of the results, you can select Results→Members in theDis-
play navigator. The display of the design ratios is Two-Colored by default.

Figure 5.4: Display navigator: Results→Members
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If you select amulticolor representation (optionsWith/WithoutDiagramorCross-Sections), the color
panel becomes available, providing common control functions. These functions are described
in detail in the RFEMmanual, Chapter 3.4.6.

Figure 5.5: Design ratios with display optionWithout Diagram

You can transfer the graphics of design results to the printout report (see Chapter 6.2, page 71).

To return to the add-on module, click [RF-STEEL EC3] in the panel.
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5.2 Result Diagrams

You can also graphically evaluate member's result distributions in a result diagram.

To do this, select the member (or set of members) in the RF-STEEL EC3 result window by clicking
in the table row of the member. Then, open the Result Diagram onMember dialog box by clicking
the button shown on the left. The button is located below the upper result table (see Figure 5.1,
page 63).

To display the result diagrams, select the command from the menu of RFEM graphic

Results → Result Diagrams for SelectedMembers

or use the corresponding button in the RFEM toolbar.

A window appears, graphically showing the distribution of the results on the member or set of
members.

Figure 5.6: Dialog box Result Diagram onMember

Also here, you can display the designs of ultimate limit state, serviceability and fire resistance using
the Results navigator.

Use the list in the toolbar above to select the relevant RF-STEEL EC3 design case.

The Result Diagram onMember dialog box is described in detail in the RFEMmanual, Chapter 9.5.
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5.3 Filter for Results

The RF-STEEL EC3 result windows allow you to sort the results by various criteria. In addition,
you can use the filter options for the windows (see Figure 5.1, page 63) to limit the numerical
output by design ratios. This function is described in the following article of the DLUBAL Blog:
www.dlubal.com/blog/11217

Furthermore, you canuse the filter options described inChapter 9.9 of theRFEMmanual to evaluate
the results graphically.

For RF-STEEL EC3, you can also use the Visibility options to filter the members in order to evaluate
them (see RFEMmanual, Chapter 9.9.1).

Filtering designs
You can easily use thedesign ratios as filter criteria in theRFEMworkwindowwhich canbe accessed
by clicking [Graphics]. To apply this function, the panel must be displayed. If the panel is not active,
you can activate it in the RFEMmenu by clicking

View → Control panel

or use the toolbar button shown on the left.

The panel is described in the RFEMmanual, Chapter 3.4.6. The filter settings for the results must
be defined in the first panel tab (Color scale). As this tab is not available for the two-colored
results display, you have to set the display option ColoredWith/Without Diagram or Cross-Sections
in the Display navigator.

Figure 5.7: Filtering design ratios with adjusted color scale

As the figure above shows, the color scale can be set in such a way that only ratios greater than
0.50 are shown in a color range between blue and red.
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The function Display hidden result diagram in the Display navigator (Results → Members) shows
all design ratios out of the value spectrum. Those diagrams are represented by dotted lines.

Filteringmembers
In the Filter tab of the control panel, you can specify the numbers of particular members to display
their results filtered. This function is described in detail in the RFEMmanual, Chapter 9.9.3.

Figure 5.8: Member filter for the design ratios of a hall frame

In contrast to the visibility function, the model will be displayed completely in the graphic. The fig-
ure above shows the design ratios of a hall frame. The remaining members are displayed in
the model but are shown without design ratios.
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6 Printout

6.1 Printout Report

Similar to RFEM, the program generates a printout report for the RF-STEEL EC3 results, to which
you can add graphics and descriptions. The selection in the printout report determines what data
from the design module will be included in the printout.

The printout report is described in the RFEM manual. In particular, Chapter 10.1.3.4 Selecting
Data of Add-onModules describes how to select input and output data from add-on modules for
the printout report.

Figure 6.1: Selecting designs and intermediate results in the printout report

Click the [Details] button to specify if you want to include intermediate results in the printout
report and document them as a list in a Short form (compact representation) or a Long form (list
representation).

For complex structural systems with many design cases, it is recommended to split the data
into several printout reports, thus allowing for a clearly-arranged printout.



6 Printout

©Dlubal Software GmbH 2015

71

6

6.2 Graphic Printout

In RFEM, you can add every picture that is displayed in the work window to the printout report or
send it directly to a printer. In this way, you can prepare the design ratios displayed in the RFEM
model for the printout, too.

The printing of graphics is described in the RFEMmanual, Chapter 10.2.

Designs in RFEMmodel
To print the currently displayed graphic of the design ratios, click

File → Print Graphic

or use the toolbar button shown on the left.

Figure 6.2: Print Graphic button in RFEM toolbar

Result Diagrams
Also in the Result Diagram onMember dialog box, you can click [Print] to transfer the graphic to
the printout report or print it directly.

Figure 6.3: Print button in the dialog box Result Diagram onMember

The following dialog box appears:

Figure 6.4: Dialog box Graphic Printout, tab General

The Graphic Printout dialog box is described in detail in the RFEMmanual, Chapter 10.2. The RFEM
manual also describes the Options and Color Scale tab.
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You canmove a graphic anywhere within the printout report by using the drag-and-drop function.

To adjust a graphic subsequently in the printout report, right-click the relevant entry in the naviga-
tor of the printout report. The Properties option in the shortcut menu opens the Graphic Printout
dialog box, offering various options for adjustment.

Figure 6.5: Dialog box Graphic Printout, tab Options
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7 General Functions
This chapter describes useful menu functions as well as export options for the designs.

7.1 Design Cases

Design cases allow you to group members for a design. In this way, you can combine groups
of structural elements or analyze members with particular design specifications (for example
modified materials, detail categories, optimization).

It is no problem to analyze the same member or set of members in different design cases.

To calculate a RF-STEEL EC3 design case, you can also use the load case list in the RFEM toolbar.

Create NewDesign Case
To create a new design case, use the RF-STEEL EC3 menu and click

File → New Case.

The following dialog box appears:

Figure 7.1: Dialog box New RF-STEEL EC3 Case

In this dialog box, enter aNumber (that is still available) of the new design case. The corresponding
Descriptionmakes the selection in the load case list easier.

Click [OK] to open the 1.1 General Datawindow in RF-STEEL EC3 where you can enter the design
data.

Rename Design Case
To change the description of a design case, use the RF-STEEL EC3 menu and click

File → Rename Case.

The following dialog box appears:

Figure 7.2: Dialog box Rename RF-STEEL EC3 Case

In this dialog box, you can specify a differentDescription as well as a differentNumber of the design
case.
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Copy Design Case
To copy the input data of the current design case, use the RF-STEEL EC3 menu and click

File → Copy Case.

The following dialog box appears:

Figure 7.3: Dialog box Copy RF-STEEL EC3 Case

Define the Number and, if necessary, a Description for the new case.

Delete Design Case
To delete design cases, use the RF-STEEL EC3 menu and click

File → Delete Case.

The following dialog box appears:

Figure 7.4: Dialog box Delete Case

You can select the design case in the list of Available Cases. To delete the selected case, click [OK].
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7.2 Cross-Section Optimization

The RF-STEEL EC3 design module offers you the option to optimize overloaded or little utilized
cross-sections. Todo this, open thedrop-down list in columnDor E in the1.3Cross-Sectionswindow
and select whether the cross-section is to be determined Fromcurrent row or from the user-defined
Favorites (see Figure 7.17, page 17). You can also start the optimization in the result windows by
using the shortcut menu.

Figure 7.5: Shortcut menu for cross-section optimization

During the optimization process, RF-STEEL EC3 determines the cross-section that fulfills the re-
sistance analysis requirements in the most “optimal” way, that is, it comes as close as possible to
the maximum allowable design ratio specified in the Details dialog box (see Figure 7.8, page 49).
The required cross-section properties are determined with the internal forces from RFEM. If an-
other cross-section proves to be more favorable, this cross-section is used for the design. Then,
the graphic in Window 1.3 shows two cross-sections: the original cross-section from RFEM and
the optimized one (see Figure 7.7).

If you select the Optimization option for a parametrized cross-section, the following dialog box
appears.

Figure 7.6: Dialog box Thin-Walled Cross-Sections - Symmetric I-Section: Optimize
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By selecting the check boxes in the Optimize column, you determine which parameter(s) you want
to modify. This enables theMinimum andMaximum columns, where you can specify the upper
and lower limits of the parameter. The Increment column determines the interval in which the size
of the parameter varies during the optimization process.

If you want to Keep current side proportions, select the corresponding check box. In addition, you
have to select at least two parameters for optimization.

Cross-sections composed of combined rolled cross-sections cannot be optimized.

Please note that the internal forces are not automatically recalculated with the modified cross-sec-
tions during the optimization: It is up to you to decide which cross-sections should be transferred
to RFEM for recalculation. As a result of optimized cross-sections, the internal forces may differ
significantly because of the modified stiffnesses in the structural system. Therefore, it is recom-
mended to recalculate the internal forces of the modified model data after the first optimization
and then to optimize the cross-sections once again.

You can export the modified cross-sections to RFEM: Go to the 1.3 Cross-Sectionswindow and click

Edit → Export All Cross-Sections to RFEM.

You can also use the shortcut menu in Window 1.3 to export optimized cross-sections to RFEM.

Figure 7.7: Shortcut menu in window 1.3 Cross-Sections

Before themodified cross-sections are transferred to RFEM, a security query appears as to whether
the results of RFEM should be deleted.

Figure 7.8: Query before transfer of modified cross-sections to RFEM
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By confirming the query and starting the [Calculation] in the RF-STEEL EC3 module, the RFEM
internal forces as well as the design ratios will be determined in a single calculation run.

If the modified cross-sections have not been exported to RFEM yet, you can reimport the original
cross-sections in the design module by using the options shown in Figure 7.7. Please note that
this option is only available in the 1.3 Cross-sectionswindow.

If you optimize a tapered member, the programmodifies the member start and end and linearly
interpolates the secondmoments of area for the intermediate locations. Since these moments are
considered with the fourth power, the designs may be inaccurate if the depths of the start and
end cross-section differ considerably. In such a case, it is recommended to divide the taper into
several members, thus modeling the taper layout manually.

7.3 Units and Decimal Places

Units and decimal places for RFEM and the add-on modules are managed in one dialog box.
In RF-STEEL EC3, you can use the menu to adjust the units. To open the corresponding dialog box,
click

Settings → Units and Decimal Places.

The following dialog box appears which you already know from RFEM. RF-STEEL EC3 is preset in
the Program /Module list.

Figure 7.9: Dialog box Units and Decimal Places

You can save the settings as a user profile to reuse them in other models. These functions are
described in Chapter 11.1.3 of the RFEMmanual.
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7.4 Data Transfer

7.4.1 ExportingMaterials to RFEM

When you have adjusted the materials in RF-STEEL EC3 for design, you can export the modified
materials to RFEM in a similar way as you export cross-sections: Open the 1.2Materialswindow
and then use the menu

Edit → Export All Materials to RFEM.

You can also export the modified materials to RFEM using the shortcut menu in Window 1.2.

Figure 7.10: Shortcut menu in the window 1.2Materials

Before the modified materials are transferred to RFEM, a security query appears as to whether the
results of RFEM should be deleted. By confirming the query and starting the [Calculation] in the
RF-STEEL EC3 module, the RFEM internal forces as well as the design ratios will be determined in a
single calculation run.

If the modified materials have not been exported to RFEM yet, you can reimport the original
materials in the design module by using the options shown in Figure 7.10. Please note, however,
that this option is only available in the 1.2Materialswindow.

7.4.2 Exporting Effective Lengths to RFEM

When you have adjusted the effective lengths in RF-STEEL EC3 for design, you can export the mod-
ified effective lengths to RFEM in a similar way as you export cross-sections: Go to the 1.5 Effective
Lengths - Memberswindow and click

Edit → Export All Effective Lengths to RFEM

or use the corresponding option in the shortcut menu of Window 1.5.

Figure 7.11: Shortcut menu of window 1.5 Effective Lengths - Members

Before themodified cross-sections are transferred to RFEM, a security query appears as to whether
the results of RFEM should be deleted.

If themodified effective lengths have not been exported to RFEM yet, you can reimport the original
effective lengths in the design module by using the options shown in Figure 7.11. Please note
that this option is only available in the windows 1.5 Effective Lengths - Members and 1.6 Effective
Lengths - Set of Members.

7.4.3 Exporting Results

The RF-STEEL EC3 results can also be used by other programs.
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Clipboard
To copy cells selected in the result windows to the Clipboard, use the keys [Ctrl]+[C]. Press [Ctrl]+[V]
to insert the cells, for example in a word processing program. The headers of the table columns
will not be transferred.

Printout Report
You can print the data of RF-STEEL EC3 into the global printout report (see Chapter 7.2, page 71)
to export them subsequently. Then, in the printout report, click

File → Export to RTF.

The function is described in the RFEMmanual, Chapter 10.1.11.

Excel / OpenOffice
RF-STEEL EC3 provides a function for directly exporting data to MS Excel, OpenOffice.org Calc, or
the CSV file format. To open the corresponding dialog box, click

File → Export Tables.

The following export dialog box appears:

Figure 7.12: Dialog box Export of Tables
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When you have selected the relevant options, you can start the export by clicking [OK]. Excel or
OpenOffice will be started automatically, you do not need to open the programs first.

Figure 7.13: Results in Excel
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8 Examples

8.1 Stability

In the following example, we perform stability analyses for flexural buckling and lateral-torsional
buckling for a column with double-bending, considering the interaction conditions.

Design Values

System and loads

Figure 8.1: System and design loads (𝛾 times)

Design values of static loads

𝑁𝑑 = 300 kN

𝑞𝑧 ,𝑑 = 5.0 kN/m

𝐹𝑦 ,𝑑 = 7.5 kN

Internal forces according to linear static analysis

N My Mz Vy Vz
Figure 8.2: Internal forces
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Design locations (governing x-location)

The design is performed for all x-locations (see Chapter 4.5) of the equivalent member. The gov-
erning location is x = 2.00 m. RFEM determines the following internal forces:

𝑁 = −300.00 kN 𝑀𝑦 = 10.00 kNm 𝑀𝑧 = 7.50 kNm 𝑉𝑦 = 3.75 kN 𝑉𝑧 = 0.00 kN

Cross-Section Properties HE-B 160, S 235

Property Symbol Value Unit

Cross-Sectional Area A 54.30 cm2

Moment of Inertia Iy 2,490.00 cm4

Moment of Inertia Iz 889.00 cm4

Radius of Gyration iy 6.78 cm

Radius of Gyration iz 4.05 cm

Polar Radius of Gyration ip 7.90 cm

Polar Radius of Gyration ip,M 41.90 cm

Section Weight G 42.63 kg/m

Torsional Constant IT 31.40 cm4

Warping Constant of Cross-Section Iu� 47,940.00 cm6

Elastic Section Modulus Wy 311.00 cm3

Elastic Section Modulus Wz 111.00 cm3

Plastic Section Modulus Wpl,y 354.00 cm3

Plastic Section Modulus Wpl,z 169.96 cm3

Buckling Curve BCy b

Buckling Curve BCz c

Table 8.1: Cross-Section Properties HE-B 160, S 235

Flexural buckling about theminor axis (⊥ to z-z axis)

𝑁𝑐𝑟 ,𝑧 =
21,000 ⋅ 889.00 ⋅ 𝜋 2

400.002 = 1,151.60 kN

𝜆𝑧 = √
𝐴 ⋅ 𝑓𝑦

𝑁𝑐𝑟 ,𝑧
= √54.30 ⋅ 23.5

1,151.60
= 1.053

𝜆𝑧 = 1.053 > 0.2 → Design for flexural buckling must be performed.

Cross-sectional geometry
ℎ
𝑏

= 1.00 ≤ 1.2 Structural steel S 235 𝑡 ≤ 100 mm

[1], Table 6.2, row 3, column 4: Buckling curve c

⇒ 𝛼𝑧 = 0.49 (Table 6.1)

𝛷 = 0.5 ⋅ [1 + 0.49 ⋅ (1.053 − 0.2) + 1.053 2] = 1.263

𝜒𝑧 =
1

1.263 +
√

1.2632 − 1.0532
= 0.510

𝑁𝐸 𝑑
𝜒𝑧 ⋅ 𝐴 ⋅ 𝑓𝑦/𝛾𝑀 1

=
300

0.510 ⋅ 54.30 ⋅ 23.5/1.0
= 0.461
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Result values of RF-STEEL EC3 calculation

Moment of Inertia Iz 889.00 cm4

Effective Member Length Lcr,z 4.000 m

Elastic Flexural Buckling Force Ncr,z 1,151.60 kN

Slenderness 𝜆z 1.053 > 0.2 6.3.1.2(4)

Buckling Curve BCz c Tab. 6.2

Imperfection Factor 𝛼z 0.490 Tab. 6.1

Auxiliary Factor 𝛷z 1.263 6.3.1.2(1)

Reduction Factor 𝜒z 0.510 Eq. (6.49)

Table 8.2: Result values of RF-STEEL EC3 calculation

Flexural buckling about themajor axis (⊥ to y-y axis)

𝑁𝑐𝑟 ,𝑦 =
21,000 ⋅ 2,490.00 ⋅ 𝜋 2

400.002 = 3,225.51 kN

𝜆𝑦 = √
𝐴 ⋅ 𝑓𝑦

𝑁𝑐𝑟 ,𝑦
= √54.30 ⋅ 23.5

3,225.51
= 0.629

𝜆𝑦 = 0.629 > 0.2 → Design for flexural buckling must be performed.

Cross-sectional geometry
ℎ
𝑏

= 1.00 ≤ 1.2 Structural steel S 235 𝑡 ≤ 100 mm

[1], Table 6.2, row 3, column 4: Buckling curve b

⇒ 𝛼𝑦 = 0.34 Table 6.1

𝛷 = 0.5 ⋅ [1 + 0.34 ⋅ (0.629 − 0.2) + 0.629 2] = 0.771

𝜒𝑌 =
1

0.771 +
√

0.7712 − 0.6292
= 0.822

𝑁𝐸 𝑑
𝜒𝑌 ⋅ 𝐴 ⋅ 𝑓𝑦/𝛾𝑀 1

=
300

0.822 ⋅ 54.30 ⋅ 23.5/1.0
= 0.286

Result values of RF-STEEL EC3 calculation

Moment of Inertia Iy 2,490.00 cm4

Effective Member Length Lcr,y 4.000 m

Elastic Flexural Buckling Force Ncr,y 3,225.51 kN

Cross-Sectional Area A 54.30 cm2

Yield Strength fy 23.50 kN/cm2 3.2.1

Slenderness 𝜆y 0.629 > 0.2 6.3.1.2(4)

Buckling Curve BCy b Tab. 6.2

Imperfection Factor 𝛼y 0.340 Tab. 6.1

Auxiliary Factor 𝛷y 0.771 6.3.1.2(1)

Reduction Factor 𝜒y 0.822 Eq. (6.49)

Table 8.3: Result values of RF-STEEL EC3 calculation
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Lateral-Torsional Buckling

Ideal elastic critical moment

In this example, the elastic critical moment for lateral-torsional buckling is determined according
to the Austrian National Annex with assumption of hinged supports free to warp.

The load application point is in the shear center (for transverse loads, you can adjust the application
point in the Details dialog box, see Chapter 3.1.2, page 44).

𝑀𝑐𝑟 = 𝐶1 ⋅
𝜋2 ⋅ 𝐸 ⋅ 𝐼𝑧

𝐿2 ⋅ √𝐼u�
𝐼𝑧

+
𝐿2 ⋅ 𝐺 ⋅ 𝐼𝑡
𝜋2 ⋅ 𝐸 ⋅ 𝐼𝑧

𝑀𝑐𝑟 = 1.13 ⋅
𝜋2 ⋅ 21,000 ⋅ 889

4002 ⋅ √47,940
889

+
4002 ⋅ 8,100 ⋅ 31.40

𝜋2 ⋅ 21,000 ⋅ 889
= 215.71 kNm

The program also showsMcr,0, which is determined on the basis of a constantmoment distribution.

For the results by x-location, the program also shows the value Mcr,x, that is, the elastic critical
moment at the x-locations relative to the elastic critical moment at the location of the maximum
moment. UsingMcr,x, the program calculates the relative slenderness 𝜆LT.

Slenderness for lateral-torsional buckling

Calculation according to [1], Clause 6.3.2.2, for location with the maximummoment at x = 2.00m:

HEB-160, Cross-section Class 1: Wy ⇒ Wpl,y = 354.0 cm3

𝜆𝐿 𝑇 = √𝑊𝑦 ⋅ 𝑓𝑦

𝑀𝑐𝑟
= √354 ⋅ 23.5

215.71
= 0.621

Reduction factor 𝜒LT

Calculation according to [1], Clause 6.3.2.3

HEB-160: h/b = 1.0 < 2.0 ⇒ Buckling curve according to b, Table 6.5

Auxiliary factor: 𝛷𝐿 𝑇 = 0.5 ⋅ [1 + 𝛼𝐿 𝑇 ⋅ (𝜆𝐿 𝑇 − 𝜆𝐿 𝑇 ,0) + 𝛽 ⋅ 𝜆2
𝐿 𝑇]

𝛷𝐿 𝑇 = 0.5 ⋅ [1 + 0.34 ⋅ (0.621 − 0.40) + 0.75 ⋅ 0.621 2] = 0.682

Limiting slenderness: 𝜆𝐿 𝑇 ,0= 0.40

Parameter (minimum value): 𝛽 = 0.75

Imperfection factor: 𝛼𝐿 𝑇 = 0.34 (Table 6.3)

𝜒𝐿 𝑇 =
1

𝛷𝐿 𝑇 + √𝛷2
𝐿 𝑇 − 𝛽 ⋅ 𝜆2

𝐿 𝑇

=
1

0.682 +
√

0.6822 − 0.75 ⋅ 0.6212
= 0.908

According to [1], Clause 6.3.2.3, the reduction factor may be modified as follows:

𝜒𝐿 𝑇 ,𝑚 𝑜𝑑=
𝜒𝐿 𝑇

𝑓
where 𝑓 = 1 − 0.5 ⋅ (1 − 𝑘𝑐) ⋅ [1 − 2.0 ⋅ (𝜆𝐿 𝑇 − 0.82)]

𝜒𝐿 𝑇 ,𝑚 𝑜𝑑=
0.908
0.972

= 0.934

For a parabolic moment diagram, we obtain the following correction factor kc:

𝑘𝑐 = 0.94 (Table 6.6)

𝑓 = 1−0.5⋅(1 − 𝑘𝑐)⋅[1 − 2.0 ⋅ (𝜆𝐿 𝑇 − 0.8)2] = 1−0.5⋅(1 − 0.94)⋅[1 − 2.0 ⋅ (0.621 − 0.8) 2]

𝑓 = 0.972
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Interaction factors kyy and kyz

Determination according to [1], Annex B, Table B.2, for structural components susceptible to
torsional deformations. The equivalent moment factor CmLT according to Table B.3 for 𝜓 = 0 is
obtained as:

𝐶𝑚 𝑦 = 𝐶𝑚 𝐿 𝑇= 0.95 + 0.05 ⋅ 𝛼ℎ = 0.95 where 𝛼ℎ =
𝑀ℎ
𝑀𝑠

=
0
10

= 0

𝑘𝑦 𝑦 = 𝐶𝑚 𝑦 ⋅ (1 + (𝜆𝑦 − 0.2) ⋅
𝑁𝐸 𝑑

𝜒𝑦 ⋅ 𝑁𝑅 𝑘/𝛾𝑀 1
) ≤ 𝐶𝑚 𝑦 ⋅ (1 + 0.8 ⋅

𝑁𝐸 𝑑
𝜒𝑦 ⋅ 𝑁𝑅 𝑘/𝛾𝑀 1

)

𝑘𝑦 𝑦 = 0.95 ⋅ (1 + (0.629 − 0.2) ⋅ 0.286) ≤ 0.95 ⋅ (1 + 0.8 ⋅ 0.286) = 1.067 ≤ 1.167

𝑘𝑦 𝑧 = 0.60 ⋅ 𝑘𝑧𝑧 = 0.60 ⋅ 1.481 = 0.888

Interaction factors kzy and kzz

Determination according to [1], Annex B, Table B.2, for structural components susceptible to
torsional deformations

The equivalent moment factor CmLT according to Table B.3 for 𝜓 = 0 is obtained as:

𝐶𝑚 𝑧 = 0.90 + 0.01 ⋅ 𝛼ℎ = 0.90 where 𝛼ℎ =
𝑀ℎ
𝑀𝑠

=
0
10

= 0

𝑘𝑧𝑦 = (1 −
0.1 ⋅ 𝜆𝑧

𝐶𝑚 𝐿 𝑇− 0.25
⋅

𝑁𝐸 𝑑
𝜒𝑧 ⋅ 𝑁𝑅 𝑘/𝛾𝑀 1

) ≥ (1 −
0.1

𝐶𝑚 𝐿 𝑇− 0.25
⋅

𝑁𝐸 𝑑
𝜒𝑧 ⋅ 𝑁𝑅 𝑘/𝛾𝑀 1

)

𝑘𝑧𝑦 = (1 −
0.1 ⋅ 1.053
0.95 − 0.25

⋅ 0.461) ≥ (1 −
0.1

0.95 − 0.25
⋅ 0.461) = 0.892 ≤ 0.934

𝑘𝑧𝑦 = 0.934

𝑘𝑧𝑧 = 𝐶𝑚 𝑧 ⋅ (1 + (2 ⋅ 𝜆𝑧 − 0.6) ⋅
𝑁𝐸 𝑑

𝜒𝑧 ⋅ 𝑁𝑅 𝑘/𝛾𝑀 1
) ≤ 𝐶𝑚 𝑧 ⋅ (1 + 1.4 ⋅

𝑁𝐸 𝑑
𝜒𝑧 ⋅ 𝑁𝑅 𝑘/𝛾𝑀 1

)

𝑘𝑧𝑧 = 0.90 ⋅ (1 + (2 ⋅ 1.053 − 0.6) ⋅ 0.461) ≤ 0.90 ⋅ (1 + 1.4 ⋅ 0.461) = 1.525 ≥ 1.481

𝑘𝑧𝑧 = 1.481

Interaction design for buckling about themajor axis and lateral-torsional buckling

𝑁𝐸 𝑑
𝜒𝑦 ⋅ 𝑁𝑅 𝑘/𝛾𝑀 1

+ 𝑘𝑦 𝑦 ⋅
𝑀𝑦 ,𝐸 𝑑

𝜒𝐿 𝑇 ⋅ 𝑀𝑦 ,𝑅 𝑘/𝛾𝑀 1
+ 𝑘𝑦 𝑧 ⋅

𝑀𝑧 ,𝐸 𝑑

𝑀𝑧 ,𝑅 𝑘/𝛾𝑀 1
≤ 1 according to [1], Eq.(6.61)

𝑀𝑦 ,𝑅 𝑘= 𝑊𝑝𝑙 ,𝑦 ⋅ 𝑓𝑦 = 354 ⋅ 23.5 = 8,319 kNcm = 83.19 kNm

𝑀𝑧 ,𝑅 𝑘= 𝑊𝑝𝑙 ,𝑧 ⋅ 𝑓𝑦 = 169.96 ⋅ 23.5 = 3,994.1 kNcm = 39.94 kNm

300
0.822 ⋅ 1,276.05/1.0

+ 1.067 ⋅
10.0

0.908 ⋅ 83.19/1.0
+ 0.888 ⋅

7.50
39.94/1.0

= 0.594 ≤ 1

Interaction design for buckling about theminor axis and lateral-torsional buckling

𝑁𝐸 𝑑
𝜒𝑧 ⋅ 𝑁𝑅 𝑘/𝛾𝑀 1

+ 𝑘𝑧𝑦 ⋅
𝑀𝑦 ,𝐸 𝑑

𝜒𝐿 𝑇 ⋅ 𝑀𝑦 ,𝑅 𝑘/𝛾𝑀 1
+ 𝑘𝑧𝑧 ⋅

𝑀𝑧 ,𝐸 𝑑

𝑀𝑧 ,𝑅 𝑘/𝛾𝑀 1
≤ 1 according to [1], Eq.(6.62)

300
0.510 ⋅ 1,276.05/1.0

+ 0.934 ⋅
10.0

0.908 ⋅ 83.19/1.0
+ 1.481 ⋅

7.50
39.94/1.0

= 0.863 ≤ 1
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Result values of RF-STEEL EC3 calculation

Section Height h 160.0 mm

Section Width b 160.0 mm

Criterion h/b 1.00 ≤ 2 Tab. 6.5

Buckling Curve BCLT b Tab. 6.5

Imperfection Factor 𝛼LT 0.340 Tab. 6.3

Shear Modulus G 8,100.00 kN/cm3

Length Factor kz 1.000

Length Factor kw 1.000

Length L 4.000 m

Warping Constant of
Cross-Section

Iw 47,940.00 cm6

Torsional Constant It 31.40 cm4

Elastic Critical Moment for LTB
for Determination of Related
Slenderness

Mcr,0 190.90 kNm

Moment Distribution DiagrMy 6) Parabola

Maximum Sagging Moment My,max 10.00 kNm

Boundary Moment My,A 0.00 kNm

Moment Ratio 𝜓 0.000

Moment Factor C1 1.130 [2]

Ideal elastic critical moment Mcr 215.71 kNm

Elastic Section Modulus Wy 354.00 cm3

Slenderness 𝜆LT 0.621 6.3.2.2(1)

Parameter 𝜆LT,0 0.400 6.3.2.3(1)

Parameter 𝛽 0.750 6.3.2.3(1)

Auxiliary Factor 𝜙LT 0.682 6.3.2.3(1)

Reduction Factor 𝜒LT 0.908 Eq. (6.57)

Correction Factor kc 0.940 6.3.2.3(2)

Modification Factor f 0.972 6.3.2.3(2)

Reduction Factor 𝜒LT,mod 0.934 Eq. (6.58)

Moment Distribution DiagrMy 3) Max in Span Tab. B.3

Moment Factor 𝜓y 1.000 Tab. B.3

Moment Mh,y 0.00 kNm Tab. B.3

Moment Ms,y 10.00 kNm Tab. B.3

RatioMh,y/Ms, y 𝛼h,y 0.000 Tab. B.3

Load Type Load z Uniform load Tab. B.3

Moment Factor Cmy 0.950 Tab. B.3

Moment Distribution DiagrMz 3) Max in Span Tab. B.3

Moment Factor 𝜓z 1.000 Tab. B.3

Moment Mh,z 0.00 kNm Tab. B.3

Moment Ms,z 7.50 kNm Tab. B.3

RatioMh,z/Ms,z 𝛼h,z 0.000 Tab. B.3

Load Type Load y Concentrated load Tab. B.3
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Moment Factor Cmz 0.900 Tab. B.3

Moment Distribution DiagrMy,LT 3) Max in Span Tab. B.3

Moment Factor 𝜓y,LT 1.000 Tab. B.3

Moment Mh,y,LT 0.00 kNm Tab. B.3

Moment Ms,y,LT 10.00 kNm Tab. B.3

RatioMh,y,LT/Ms,y,LT 𝛼h,y,LT 0.000 Tab. B.3

Load Type Load z Uniform load Tab. B.3

Moment Factor CmLT 0.950 Tab. B.3

Component Type Component Torsionally Weak

Interaction Factor kyy 1.067 Tab. B.2

Interaction Factor kyz 0.888 Tab. A.1

Interaction Factor kzy 0.934 Tab. A.1

Interaction Factor kzz 1.481 Tab. A.1

Axial Force (Compression) NEd 300.00 kN

Cross-Sectional Area Ai 54.30 cm2 Tab. 6.7

Compression Resistance NRk 1,276.05 kN Tab. 6.7

Partial Factor 𝛾M1 1.000 6.1

Design Component for N 𝛾Ny 0.29 ≤ 1 Eq. (6.61)

Design Component for N hNz 0.46 ≤ 1 Eq. (6.62)

Moment My,Ed 10.00 kNm

Moment Resistance My,Rk 83.19 kNm Tab. 6.7

Moment Component 𝜂My 0.13 Eq. (6.61)

Moment Mz,Ed 7.50 kNm

Elastic Section Modulus Wz 169.96 cm3

Moment Resistance Mz,Rk 39.94 kNm Tab. 6.7

Moment Component 𝜂Mz 0.19 Eq. (6.61)

Design 1 𝜂1 0.59 ≤ 1 Eq. (6.61)

Design 2 𝜂2 0.86 ≤ 1 Eq. (6.62)

Table 8.4: Result values of RF-STEEL EC3 calculation
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2.1 Fire Resistance

In this example, we perform the fire design of a steel column.

System and Loads

Figure 8.3: System and loads

Column cross-section: HE-B 300, Steel S 235

System: Hinged column, 𝛽 = 1.0

System height: 3.00 m

Loading: GK = 1,200 kN

QK = 600 kN

Ultimate Limit State Design for Room Temperature

Flexural buckling about theminor axis (⊥ to z-z axis)

𝑁𝑐𝑟 ,𝑧 =
21,000 ⋅ 8,560.00 ⋅ 𝜋 2

300.002 = 19,712.90 kN

𝜆𝑧 = √
𝐴 ⋅ 𝑓𝑦

𝑁𝑐𝑟 ,𝑧
= √149.0 ⋅ 24.0

19,712.90
= 0.426

𝜆𝑧 = 0.426 > 0.2 → Design for flexural buckling must be performed.

Cross-sectional geometry ℎ/𝑏 = 1.00 ≤ 1.2 Structural steel S 235 𝑡 ≤ 100 mm

[1], Table 6.2, row 3, column 4: Buckling curve c

⇒ 𝛼𝑧 = 0.49 (Table 6.1)

𝛷 = 0.5 ⋅ [1 + 0.49 ⋅ (0.426 − 0.2) + 0.4262] = 0.646

𝜒𝑍 =
1

0.646 +
√

0.6462 − 0.4262
= 0.884

𝑁𝐸 𝑑= 1.35 ⋅ 𝐺𝐾 + 1.5 ⋅ 𝑄𝐾 = 1.35 ⋅ 1,200 + 1.5 ⋅ 600 = 2,520 kN

Design ratio

𝑁𝐸 𝑑
𝜒𝑍 ⋅ 𝐴 ⋅ 𝑓𝑦/𝛾𝑀 1

=
2,520

0.884 ⋅ 149.0 ⋅ 24.0/1.1
= 0.877 ≤ 1.0
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Result values of RF-STEEL EC3 calculation

Moment of Inertia Iz 8,560.00 cm4

Effective Member Length Lcr,z 3.000 m

Elastic Flexural Buckling Force Ncr,z 19,712.9 kN

Slenderness 𝜆z 0.4,259 > 0.2 6.3.1.2(4)

Buckling Curve BCz c Tab. 6.2

Imperfection Factor 𝛼z 0.490 Tab. 6.1

Auxiliary Factor 𝛷z 0.646 6.3.1.2(1)

Reduction Factor 𝜒z 0.884 Eq. (6.49)

Buckling Resistance Nb,z,Rd 2,872.27 kN Eq. (6.47)

Design ratio 𝜂 0.877 ≤ 1.0 Eq. (6.46)

Table 8.5: Result values of RF-STEEL EC3 calculation

Fire Resistance Design
After a fire exposure of 90 min, the mean steel temperature is 524 °C, according to the standard
temperature-time curve.

As a fire resistance material, a box-shaped GRP encasement (glass-reinforced plastic) is used, hav-
ing the following properties:

Unit Mass: 𝜌p = 945.0 kg/m3

Thermal Conductivity: 𝜆p = 0.20 W/K
Specific Heat: cp = 1,700 J/kgK
Thickness: dp = 18 mm

Determination of reduction factors

ky,u� = 0.703 according to [2], Table 3.1

kE,u� = 0.528 according to [2], Table 3.1

Design in fire situation according to [2], 4.2.3.2

Imperfection factor 𝛼:

𝛼 = 0.65 ⋅ √
235
𝑓𝑦

= 0.65 ⋅ √235
240

= 0.643

Non-dimensional slenderness ratio 𝜆u�:

𝜆u� = 𝜆 ⋅ [
𝑘𝑦 ,u�

𝑘𝐸 ,u�
]

0.5

= 0.426 ⋅ [
0.703
0.528

]
0.5

= 0.491

Auxiliary factor:

𝛷u� =
1
2

⋅ [1 + 𝛼 ⋅ 𝜆u� + 𝜆2
u� ] =

1
2

⋅ [1 + 0.643 ⋅ 0.491 + 0.491 2] = 0.778

Reduction factor for flexural buckling in the fire design situation:

𝜒𝑓 𝑖 =
1

𝜑u� + √𝜑2
u� − 𝜆2

u�

=
1

0.778 +
√

0.7782 − 0.4912
= 0.723
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Buckling resistance of structural component subjected to compression:

𝑁𝑏,𝑓 𝑖 ,𝑅 𝑑=
𝜒𝑓 𝑖 ⋅ 𝐴 ⋅ 𝑘𝑦 ,u� ⋅ 𝑓𝑦

𝛾𝑀 ,𝑓 𝑖
=

0.723 ⋅ 149.0 ⋅ 0.703 ⋅ 24
1.0

= 1,817.83

Loading in case of fire:

𝑁𝑓 𝑖 ,𝐸 𝑑= 1.0 ⋅ 𝐺𝑘 + 0.9 ⋅ 𝑄𝑘 = 1.0 ⋅ 1,200 + 0.9 ⋅ 600 = 1,740 kN

Design ratio

𝜂 =
𝑁𝑓 𝑖 ,𝐸 𝑑

𝑁𝑏,𝑓 𝑖 ,𝑅 𝑑
=

1,740
1,817.83

= 0.957 ≤ 1.0

Result values of RF-STEEL EC3 calculation

Reduction Factor ky,u� 0.703 [2], Tab. 3.1

Reduction Factor kE,u� 0.528 [2], Tab. 3.1

Slenderness 𝜆z,u� 0.4,915 [2], Eq. (4.7)

Imperfection Factor 𝛼 0.6,432 [2], 4.2.3.2(2)

Auxiliary Factor 𝛷z,u� 0.778 [2], 4.2.3.2(2)

Reduction Factor 𝜒z,fi 0.723 [2], Eq. (4.6)

Buckling Resistance Nb,fi,z,u�,Rd 1,817.83 kN

Design ratio 𝜂 0.957 ≤ 1.0 [2], Eq. (4.1)

Table 8.6: Result values of RF-STEEL EC3 calculation
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